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Introduction 

Windows 7 is Microsoft’s newest operating system. If you 
are looking to add a personal touch to your installation of 
Windows 7, this book will help you get started. 

There are thousands of customizations you can apply and 
this pocket guide only scratches the surface. As always, 
I’ve written this book so anyone can pick it up and work 
through it. 

I recommend you begin by reading the first chapter—Get 
Started; this chapter will give you a good foundation for 
the rest of the book. A basic knowledge of how Windows 
works is required to follow most of the sections; however, 
if you are very new with computers, I am confident you will 
learn a great amount as you go through this book—taking 
things one step at a time. 

Once you have read the Get Started section, you’re ready 
to explore the rest of the book and personalize your 
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machine to match your style. I’m sure there’s something 
here for everyone; take a browse through the Contents 
page and see what strikes your interest. You do not need 
to read this book in order; feel free to explore. 

If you have questions or feedback, head to the Contact Me 
section at the end of this book and get in touch with me. Is 

If this version of the book seems a little dated, head to 
Windows Guides for an updated version. 

I began writing this book as soon as the public beta came 
out. I felt this was a good time to start getting familiar 
with the features that would soon be ready with the 
released version of the operating system. However, as 
features are updated, some of these sections may no 
longer work exactly as stated. I will continually update this 
book and make sure that it's ready for the final release of 
Windows 7. Please note: This guide is up to date as of 
Windows 7 RTM (Released August 6, 2009.) 

Notational Conventions 

In this guide, I have used these notational conventions: 

http://mintywhite.com/tech/books/�
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Italic: Text from the current dialogue you are working with. 

Bold: the name of a keyboard key. 

Italic bold: something you type as shown, e.g., regedit.  
Unless otherwise specified, you can use uppercase or 
lowercase letter. Note that some URLs extend over multiple 
lines in this guide; when you type them, do not insert 
spaces between parts of the URL. 

Click: move the cursor to the referenced item and press 
the left mouse button. 

Press: push on a keyboard key. 

Select: choose from a list. 

Blue Links: Links to external websites 

Green Links: Links to navigate within this book 
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Additional Help 

I’ve organized the following resources to help you use this 
book and improve your skills with and knowledge of 
Windows 7: 

• Glossary: Common terms are explained here. 
• Appendices: Common tasks are taught here. 
• Index: Search the book and find relevant 

information. 
• Windows 7 Forum: Meet Windows 7 enthusiasts 

and get your questions answered. 
• Windows 7 Resources: Get the latest tips and 

guides here. 
• Contact Me: Get in touch with me if you have 

questions. 

 

http://mintywhite.com/forum/�
http://mintywhite.com/tech/category/windows-7/�


 

 

1 Get Started 

Before you get started with this book, there are a few 
questions you should ask yourself: 

• Should I install Windows 7 and still keep Vista or XP 
on my computer? 

• What version of Windows 7 should I use? 
• Should I upgrade or do a clean installation? 
• Should I use the 32 or 64 bit version of Windows 7? 

This chapter addresses these questions and helps you get 
the answers that best suit your needs. 

In the latter half of this chapter, you’ll learn about the 
Windows Registry and Group Policy Editor, which are 
referenced throughout this book. 

Enjoy working through this book and remember: More is 
less when you customize your system; don’t try to change 
every last thing. Make changes that look good and keep 
your system clean and tidy. 
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1.1 Windows 7 System Requirements 

The minimum system requirements to run Windows 7 are: 

• 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit 
(x64)  

• 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit) 
• 16 GB available hard disk space (32-bit) or 20 GB 

(64-bit) 
• DirectX 9 graphics device with WDDM 1.0 or higher 

driver 

Additional requirements to use certain features: 

• Internet access (fees may apply) 
• Depending on resolution, video playback may 

require additional memory and advanced graphics 
hardware 

• For some Windows Media Center functionality a TV 
tuner and additional hardware may be required 

• Windows Touch and Tablet PCs require specific 
hardware 
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• HomeGroup requires a network and PCs running 
Windows 7 

• DVD/CD authoring requires a compatible optical 
drive 

• BitLocker requires Trusted Platform Module (TPM) 
1.2 

• BitLocker To Go requires a USB flash drive 
• Windows XP Mode requires an additional 1 GB of 

RAM, an additional 15 GB of available hard disk 
space, and a processor capable of hardware 
virtualization with Intel VT or AMD-V turned on 

• Music and sound require audio output 

Product functionality and graphics may vary based on your 
system configuration. Some features may require advanced 
or additional hardware. 

I’ve tested Windows 7 with 512MB of RAM and found it to 
work well; however, I do not recommend running with 
such low memory—unless you really have to. 

http://mintywhite.com/tech/windows-7/windows-seven-7-runs-flawlessly-on-512mb-ram/�
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1.2 Which Version of Windows 7? 

Windows 7 is available in four editions. Windows 7 Starter 
is not sold individually, so I will not explain its features. I 
personally recommend Windows 7 Home Premium as this 
is suitable for home use and will provide you with most of 
the functionality needed to do everything in this book. 
However, if you want all the features, you’ll need Windows 
7 Ultimate. 

1.2.1 Buy Your Copy of Windows 7 

 

Upgrade Full Version 

http://www.amazon.com/gp/product/B002DHLUWK?ie=UTF8&tag=witohegu-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002DHLUWK�
http://www.amazon.com/gp/product/B002DHGMK0?ie=UTF8&tag=witohegu-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002DHGMK0�
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Upgrade Full Version 

 

Upgrade Full Version 

 

Microsoft compiled a feature chart, which is included in 
this guide for your convenience: 

http://www.amazon.com/gp/product/B002DHGM50?ie=UTF8&tag=witohegu-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002DHGM50�
http://www.amazon.com/gp/product/B002DHLVII?ie=UTF8&tag=witohegu-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002DHLVII�
http://www.amazon.com/gp/product/B002DHLV8S?ie=UTF8&tag=witohegu-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002DHLV8S�
http://www.amazon.com/gp/product/B002DHGMVY?ie=UTF8&tag=witohegu-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002DHGMVY�
http://windows.microsoft.com/en-us/windows7/products/compare-editions�
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1.3 Windows 7 32 or 64-bit? 

When deciding to move up to a 64-bit operating system, 
you should first consider what 64-bit gets you. Knowing 
what software runs on 64-bit should influence your 
decision; you will see no advantage if you are running 32-
bit software on a 64-bit OS. You also lose the ability to run 
16-bit software, which shouldn’t be a problem unless you 
rely on older software, such as old work software or 
home-made packages you haven’t yet updated. 

1.3.1 What Does 64-Bit 7 Get Me? 

More bits gets you access to more memory; the processor 
inside your PC communicates with your system memory 
(RAM) with numeric addressing. Thus, the maximum 
amount of memory a 32-bit processor can address is 4 
gigabytes. Newer 64-bit processors—not to mention the 
64-bit operating systems that run on them—can address 
17,179,869,184 gigabytes (16 exabytes) of RAM. 

Windows NT, released in 1993, was Microsoft’s first fully 
32-bit operating system; however, it took eight years 
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before the platform, which had since evolved into Windows 
2000 and then XP, became mainstream. (Yes, Windows 9x 
ran 32-bit applications, but it was a hybrid OS that ran on 
a 16-bit DOS foundation, which was one of the reasons it 
was so unstable.) 64-bit Windows became a reality in XP, 
and Vista was Microsoft’s first serious attempt to make 
64-bit computing mainstream. I am sure more people will 
use Windows 7 64 bit because of the increasing demands 
for more RAM. The question is: how mainstream is 64 bit? 

1.3.2 How Mainstream is 64 bit? 

While 64-bit Windows 7 can run most 32-bit applications 
without a problem, it’s not compatible with 32-bit 
hardware drivers or 32-bit utilities like Windows Explorer 
extensions (e.g., context menu add-ons.) This means you 
need a native 64-bit driver for every device on your PC; 
finding support for all your hardware can be a bit of a 
challenge, at least on older computers 
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1.3.3 Is there a Performance Increase? 

Now, 64-bit software running on 64-bit Windows has been 
known to run as much as 10% faster, which illustrates the 
other reason—aside from memory addressing—that people 
find 64-bit 7 alluring. Just be prepared for lackluster 
industry support, at least for the next few years until 
Microsoft releases a 64-bit-only OS. 

1.4 Install Windows 7  

Now you’ve decided which version of Windows 7 to use, 
you should check your system’s compatibility online. If 
your PC is compatible, you have four options: 

1. Upgrade to 7 from Windows Vista 
2. Install Windows 7 as a Virtual Machine 
3. Dual Boot Windows XP/Vista with Windows  
4. Install Windows from Scratch 

You’ll learn how to do each of these in this section. 

http://www.microsoft.com/windows/windows-7/get/upgrade-advisor.aspx�
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1.4.1 Upgrade to 7 from Windows Vista 

Upgrading is the easiest option of the three. However, 
upgrading can take a long time. To upgrade to Windows 7 
from Windows Vista: 

1. Insert the Windows 7 DVD into your DVD-ROM 
drive. 

2. Click Run setup.exe from the Autoplay menu. 
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3. Click Install now on the Install Windows screen. 

 

4. Setup will begin by copying files to your computer. 
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5. I recommend you get Windows updates online 
before upgrading Windows. This will ensure greater 
security and compatibility. 
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6. Accept the license terms and click Next. 



Windows 7 – The Pocket Guide 14 
 

 

 

7. Now click Upgrade and follow the instructions. You 
may get a compatibility report, which will help you 
determine what may not work properly after the 
upgrade. 
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1.4.2 Install Windows 7 as a Virtual Machine 

If you would like to use Windows 7 and still use Windows 
Vista or XP, rebooting your computer every time can be a 
pain. A virtual machine (VM) can be used to simulate 
hardware and run Windows (or any operating system) 
within Windows. 

1.4.2.1 Install Virtual Box 

Virtual box is a VM host that facilities in VM creation and 
deployment. To install virtual box: 
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1. Download Virtual Box. 
2. Install Virtual Box and ensure all options are 

selected via the Custom Setup. 

 

3. You’ll be asked whether you want to install drivers; 
these are essential and should be installed. 

http://www.virtualbox.org/�
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4. Open Virtual Box and click New. 

 

5.  On the Virtual Machine Wizard, click Next. 
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6. Give the VM a name (Windows 7 will do) and select 
Windows 7 from the Version drop down list. 



19 1 Get Started 
 

 

 

7. Select the amount of memory you want to use (I 
recommend using no more than half your physical 
RAM amount i.e., 4GB RAM = 2GB allocated.) 
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8. Select Create new hard disk. 
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9. Click Next. 
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10. Select Dynamically expanding storage and click 
Next. 
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11. Choose where you will save your VM data. 
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12. Click Next. 
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13. Click Finish. 
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14. Click Finish to create your VM. 
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1.4.2.2 Install Windows 7 as a VM 

Now you’ve created your VM, you’ll need to boot it up and 
install the operating system: 

1. Open Virtual Box, click your VM, and click Start. 
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2. Click Next. 
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3. Leave CD/DVD Rom Device selected. If you are 
using the Windows 7 DVD (upgrade DVDs wont 
work for a clean install), click Next. If you are using 
an ISO image, select Image File and browse to your 
ISO. 
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4. ISO Only: Click Add to browse to your ISO file. 
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5. ISO Only: Locate your ISO and click Open. 

 

6. ISO Only: Click Select. 
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7. Click Finish to begin installation. 
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8. Windows 7 will now boot. 
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9. Refer to Install Windows from Scratch to install 
Windows 7 as a VM. 

1.4.3 Dual Boot Windows XP/Vista with 
Windows 7 

Dual booting Windows is the most challenging of the three 
options; however, making it work can be very rewarding. 
The process of creating a dual boot environment differs 
from Windows Vista to XP. Please follow the instructions 
according to which version of Windows you are currently 
using.  

To run two operating systems on your computer, you will 
need to add a second partition. If you are not familiar with 
adding a partition, you can learn how in this section. 
Please note: each operating system will be able to see the 
other partition; thus, you can share files between them. 

1.4.3.1 Dual Boot Windows XP with Windows 7 

You will need third party software to create a second 
partition for Windows 7; once you have created the 
partition, you can install Windows 7 on it. 
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Create a New Partition (XP) 

To create a second partition on your hard drive in Windows 
XP: 

1. Download the GParted live CD here. 
2. Burn the image to a CD (Appendix G: Burn an ISO 

Image to a Disc), reboot your computer, and boot 
from the CD (Appendix H: Boot from a CD or DVD.) 

3. Once you’ve booted into GParted, create a partition 
for Windows 7 (16 GB+ recommended) (Appendix I: 
Create a Partition with GParted.) 

Refer to the Install Windows from Scratch section of this 
chapter to learn how to install Windows 7 on your newly 
created partition. 

1.4.3.2 Dual Boot Windows Vista with Windows 7 

Windows Vista natively manages partitions; you will need 
to create a second partition for Windows 7. Once you have 
created the partition, you can install Windows 7 on it. 

http://gparted.sourceforge.net/download.php�
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Create a New Partition (Vista) 

To create a second partition on your hard drive in Windows 
Vista: 

1. Click the Start button, right click Computer, and 
click Manage. 

 
2. In the left pane, click Disk Management. 

 
3. Now create a new partition by shrinking a previous 

volume so you can use the newly created space. 
Right click on the partition and click Shrink 
Volume. 
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4. Input the size, in MB, by which you want to shrink 

the partition. I recommend 32 GB (32,768 MB.) 
Windows 7 requires a minimum of 16 GB (16,384 
MB.) 
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5. Now right click the free space and click New Simple 
Volume… 

 
6. Click Next. 

 
7. Specify the volume size and click Next. 
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8. Assign an unused letter to the drive and click Next. 
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9. Format the drive as NTFS, give it a label, and click 
Next. 
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10. Click Finish. 

 

Refer to Install Windows from Scratch to learn how to 
install Windows 7 on your newly created partition. 

1.4.4 Install Windows from Scratch 

Whether you are installing Windows 7 on a blank hard 
drive or a newly created partition, the procedure is the 
same.  

To install Windows 7 from scratch: 
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1. Power on your computer, insert the Windows 7 
DVD, and restart your computer. 

2. Press the necessary key to initiate booting from 
your DVD (usually Esc or F12.) (Appendix H: Boot 
from a CD or DVD.) 

3. Windows will now load the installation files. 

 
4. Click Install now. 

 



43 1 Get Started 
 

 

5. On the Get important updates for installation page, 
I recommend getting the latest updates to help 
ensure a successful installation and protect your 
computer against security threats. You need an 
Internet connection to get updates. 

6. On the Please read the license terms page, if you 
accept the license terms, click I accept the license 
terms. (You must accept to continue the 
installation.) 

7. On the Which type of installation do you want? 
page, click Custom. 

8. On the Where do you want to install Windows? 
page: 

a. Click Next to begin the installation (unless 
you want to create a partition.)  

b. OR If you already have another existing 
partition with enough free space and want 
to install Windows 7 on that partition to 
create a multi-boot configuration, select the 
partition you want to use, and click Next to 
begin the installation. (Be sure to install 
Windows 7 on a different partition from 
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where your current version of Windows is 
installed.) 

Windows will take some time to install, so be patient 

Figure 1: Installing Updates 

Your computer will restart several times during the 
process as it configures itself and installs updates (Figure 
1.) Be sure to leave the DVD in the drive and let Windows 
take care of itself. 
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Figure 2: Installation Complete 

After some time, Windows will now be installed (Figure 2.) 
If you are running a dual boot, you should have the choice 
of either version of Windows when you power on your 
computer. 

1.5 Use Virtual XP Mode 

Windows 7 comes with built-in support to virtually run 
Windows XP. This is a great feature for those who are still 
holding on to XP or have applications that are not 
compatible with Windows 7 and Vista. 

1.5.1 Requirements for XP mode 

• Check for compatibility with SecurAble. 
• 1 GHz 32-bit / 64-bit processor required. 

http://www.grc.com/securable.htm�
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• Memory (RAM) – 1.25 GB required, 2 GB memory 
recommended. 

• Recommended 15 GB hard disk space per virtual 
Windows environment. 

• NB: Windows XP Mode is only available in Windows 
7 Enterprise, Windows 7 Professional, and Windows 
7 Ultimate. 

1.5.2 Windows Virtual PC features for 
Windows XP Mode 

• Once both the Windows Virtual PC and the virtual 
Windows XP environment are installed, Windows 
Virtual PC provides a simple wizard to setup the 
Windows XP Mode with just a few clicks. 

• Users can access USB devices attached to Windows 
7 directly from Windows XP Mode.  These devices 
include Printers and Scanners, Flash Memory/Sticks 
and External Hard Disks, Digital Cameras and 
more. 

• Publish and Launch applications installed on 
Windows XP Mode directly from the Windows 7 
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desktop, as if they were installed on the Windows 7 
itself. 

• Access your Windows 7 Known Folders -  My 
documents, Pictures, Desktop, Music, Video, from 
inside the virtual windows environment, such as 
Windows XP Mode. 

• Cut and paste between your Windows 7 and 
Windows XP Mode. 

• Print directly to your attached printer from your 
Windows XP Mode applications either in application 
mode or desktop mode. 

More information available here. 

1.5.3 Install and Use Virtual XP Mode 

To enable and use Virtual XP mode, first check for 
compatibility, with SecurAble, or you’ll be presented with 
the error below: 

http://www.microsoft.com/windows/virtual-pc/default.aspx�
http://www.grc.com/securable.htm�
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1. Download Windows XP Mode and Windows Virtual 
PC. 

2. Install Windows6.1-KB958559-x86.msu. 
3. Restart Your Computer. 
4. Install VirtualWindowsXP.msi and accept the default 

settings. 
5. Set a login Password. 

http://www.microsoft.com/windows/virtual-pc/default.aspx�
http://www.microsoft.com/windows/virtual-pc/default.aspx�
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6. I recommend enabling Automatic Updates. 
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7. Windows XP will now install and be ready to use. 

1.6 Transfer Your Files from Your Old 
PC 

Windows Easy Transfer is used to transfer your files from 
your old PC (Windows XP, Vista, or 7) to your new PC. 
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You can transfer your files through the following ways:  

• An Easy Transfer Cable 
• A Network 
• An external hard disk of USB flash drive 
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You can specify which accounts to move to your new PC 
and everything is pretty simple at straight forward. 

To use Windows Easy Transfer: click Start, type transf and 
click Windows Easy Transfer. Follow the on-screen 
instructions to copy your data. 
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1.7 About the Windows Registry 

Throughout this book, some sections require you to 
access the Windows Registry and make changes. I try to 
make executable registry hacks in most cases, but it can 
be fun to script or create your own registry files. Before 
doing anything with the Windows Registry, you should 
know what the registry is, how to back it up, how to 
restore it to a previous state, and how to add keys and 
values. 

1.7.1 What is the Windows Registry? 

Think of the Windows registry as a control center for your 
computer. Windows settings, individual program settings, 
and other important configuration information are stored 
here. 

The registry is made up of the following components: 

• Keys 
• Subkeys 
• Values 
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1.7.2 Access the Windows Registry Editor 

 
Figure 3: Starting Registry Editor 

Figure 3 shows how to open the registry editor. For more 
information, see Appendix D: Launch Windows Registry 
Editor. 

1.7.3 Add Keys or Values 

In some of the tutorials in this book, you will need to 
create a new key or value. 

1.7.3.1 Add a New Key 

To add a new key: 

1. Right click on the parent key. 
2. Click New > Key. 
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3. Follow the section’s instructions for what key name 

to assign. 

1.7.3.2 Add a New Value 

To add a new value: 

1. Navigate to the key that you want to add a value to. 
2. Right click in the blank space of the right pane. 
3. Click New > xx (Where xx is the value specified in 

the section.) 
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4. Follow the section’s instructions for what value to 
assign. 

1.7.4 Back up the Registry 

To back up the registry, please refer to Appendix E: Back 
up the Windows Registry. 

1.8 About the Group Policy Editor 

Group Policy is a feature of Microsoft Windows that 
provides centralized management and configuration for 
your computer or computers in a domain. This tool is 
mainly used by systems administrators to control a group 
of PCs; however, you can use it to customize your personal 
machine. 

Please Note: The Group Policy Editor (Figure 5) is not 
included with every version of Windows 7 and is currently 
only available in Windows 7 Ultimate. 
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1.8.1 Access the Group Policy Editor 

Click the Start button, type gpedit.msc, and press Enter 
(Figure 4.) 

 
Figure 4: Access the Group Policy Editor 
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1.8.2 Work with the Group Policy Editor 

 

Figure 5: The Group Policy Editor 

To enable options, double click on the specified option in 
the right-hand pane, and change the setting to Enabled 
(Figure 6.) 
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Figure 6: Enabling/Disabling Options in Group Policy Editor 

1.9 You Are Ready to Begin 

You made it this far and now you are ready to begin. As a 
brief recap, you learned the requirements of Windows 7, 
the version to install, and how to install your chosen 
version. You also learned about the Windows Registry and 
the Group Policy Editor. I strongly suggest you review the 2 
Back up Your Data chapter before proceeding; however, 
you’re welcome to explore and experiment—hopefully 
you’ll learn something new along the way. 



 

 

2 Back up Your Data 

If you are not familiar with data backup or currently 
choose not to back up your files, please read this chapter. 
Making changes to your computer brings a certain level of 
risk. This risk is alleviated greatly when you make backups 
that are timely, complete, and functional. 

If you are one of the lucky people who have never lost a 
file on your computer, congratulations; however, this 
chapter is still for you. If you have lost files before—yep 
that’s you—then you should review this chapter too before 
you begin.  

In this chapter, you’ll learn how to use Backup and 
Restore, backup and restore your registry, and how to 
recover lost files. 
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2.1 Backup and Restore 

Backup and Restore—bundled with Windows 7—is an 
excellent tool, which allows you to backup and restore 
either your files or an image of your operating system. 

2.1.1 Launch Backup and Restore 

To launch the Backup and Restore Center: 

1. Click the Start button and type Backup. 

 
2. Click Backup and Restore. 

2.1.2 Back up Your Files 

To back up your files: 

1. Click Set up backup…  
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2. Windows will now prepare your system for backup. 

 

3. Choose a backup destination and click Next. 
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4. I recommend you choose your files to backup. 
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5. Specify the files you want to backup. You can 
include a system image, which will save your 
Windows settings as they are. This can be restored 
if something goes really wrong. 
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6. Review your backup settings. 
7. Set the frequency of backup. 
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8. Windows will now backup your files. 

 

2.1.3 Restoring Your Files 

Launch Backup and Restore and click Restore Files. Locate 
your backup files and follow the instructions to get your 
previously backed up files back. 
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2.2 Back Up and Restore the Registry  

Some sections in this book will require you to change 
values in your registry. If you make a mistake and don’t 
correct it, you may find your computer is not as functional 
as it was before. To protect yourself from any mistakes, 
you need to backup your registry. 

2.2.1 Back up the Registry 

See: Appendix E: Back up the Windows Registry. 

2.2.2 Restore the Registry 

Before restoring the registry, make a back up, so you can 
roll back if anything goes wrong. To restore your registry 
from a backup: 

1. Open the Registry Editor (Appendix D: Launch 
Windows Registry Editor.) 

2. Left click Computer in the left pane. 
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3. Go to File > Import. 

 
4. Click your backup file and click Open. 
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2.3 Create a System Recovery Disc 

If Windows 7 goes wrong, you can attempt a repair, at 
boot up, to see if the problem can be fixed. To do this, you 
will need to create a system recovery disc; if you have the 
original Windows 7 disc, it will act as a recovery disc.  

The system recovery disc cannot be used to install 
Windows, but it can be used to fix common problems that 
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prevent Windows from booting. I recommend you make a 
system recovery disc before playing with Windows’ 
settings. 

To create a system recovery disc: 

1. Click the Start button. 
2. Type Backup. 

 
3. Click Backup and Restore. 
4. In the left column, click Create a system repair disc. 

 
5. Select your DVD drive and click Create disc. 
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6. Wait for the disc to burn. 

 

7. Test the disc by rebooting your PC with the disc in 
the drive. Boot from the optical drive (Appendix H: 
Boot from a CD or DVD) and ensure the disc works 
by waiting for the main menu to load; if the menu 
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loads, you should be good to go in the event of a 
computer problem. 

8. Save the recovery disc in a safe place. 

2.4 Recovering Lost Data on Your Drive 

If you lose your data, be sure to check the recycle bin first. 
If there are no files in the recycle bin, there is still hope. 
Even though your files are deleted, the data may still be 
recoverable because the reference to the file has simply 
been deleted and not the data itself. As long as your file 
has not been overwritten, you have a chance at recovery.  

After trying many file recovery programs, I’ve decided 
Recuva is by far the best.  

Recuva (pronounced “recover”) is a freeware Windows 
utility to restore files that have been accidentally deleted 
from your computer. This includes files emptied from the 
Recycle bin as well as images and other files that have 
been deleted by user error from digital camera memory 
cards or MP3 players. It will even bring back files that have 
been deleted by bugs, crashes and viruses!  

http://www.recuva.com/download�


 

 

3 Security 

One of the most important ways to protect yourself, when 
you are using your computer, is to be in control of 
security. There are so many threats out there that it is 
important to be proactive and protect your computer. 

In this chapter, you will learn how to choose anti-virus, 
anti-malware, and firewall software; how to take 
ownership of your files; how to encrypt your sensitive data; 
and how to protect your privacy online and in Windows 
Media Player 11. While there are many PC security options 
available, this section should give you a good start. 

3.1 Choose an Anti-virus Program 

To protect yourself, you must have an anti-virus program. 
A virus is designed to disrupt the normal operation of your 
PC and can be costly: both in your time and in repairs that 
need to be made to recover your system.  
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Microsoft currently supplies a list of all vendors whose 
software works with Windows 7. Of the current software, I 
recommend AVG Free, which is free for personal use. 

3.2 Anti-spyware Software 

Anti-spyware software helps you keep malicious software 
off your PC. Spyware is malicious programs that often send 
personal data, passwords and other private personal and 
financial data to third parties.  

As listed above: you can visit Microsoft’s list of compatible 
security programs. AVG comes with a great anti-spyware 
module that should keep you free of harm. 

3.3 Firewalls 

A firewall is a hardware or software device that controls 
access to computers on a Local Area Network (LAN.) It 
examines all traffic routed between the two networks - 
inbound and outbound—to see if it meets certain criteria. 
If it does it is routed between the networks, otherwise it is 

http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx�
http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx�
http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx�
http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx�
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stopped. It can also manage public access to private 
networked resources such as host applications. 

Many people got to great lengths to find a good firewall 
and often pay large sums of money to increase protection. 
For the average home user, Windows Firewall is sufficient 
and will protect you from unwanted communications 
between your computer and the world wide web. 

To access Windows Firewall: Click the Start button, type 
fire, and click Windows Firewall.  

3.4 Add Take Ownership to Context 
Menu 

Many folders in 7 are protected from changes and require 
administrative approval to change every time. Sometimes 
this can become tedious, so I’ve created a registry hack 
you can use to take ownership of your files. 

1. Download TakeOwnership.zip. 
2. Unzip the file. 

http://mintywhite.com/images/techtips/0804/10takeowner/TakeOwnership.zip�
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3. Double click InstallTakeOwnership.reg and accept 
the prompts. 

4. You can now take ownership of a file by right 
clicking it and clicking Take Ownership. 

Remove Take Ownership from your context menu by 
merging RemoveTakeOwnership.reg into your registry. 

3.5 Encrypt your USB Drive’s Data 

Please note: I prefer TrueCrypt, which is explained in this 
section; however, Windows 7 is bundled with USB 
encryption software: BitLocker To Go. 

Do you have data on your USB drive that could be accessed 
by someone if they found your key drive? Do you have 
sensitive data that you need to protect, but don’t want to 
pay for expensive software? TrueCrypt was designed for 
you and in this section you’ll learn how to use it. If you 
would like to protect data on your hard drive, move to the 
next section where I show you an easier-to-use program. 

This section is written for TrueCrypt 6.2a (currently not 
compatible with Windows 7, but it works for the desired 
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outcome of this section); newer versions should operate in 
a similar fashion. 

I will refer to your USB drive as a “USB key drive” 
throughout this section. If you are encrypting your hard 
disk drive, simply replace this phrase with “hard disk 
drive”—the procedure is identical. 

Final word: do not encrypt the entire drive your OS is 
stored on. You can encrypt parts of the drive, but not 
system files. 

3.5.1 Download TrueCrypt 

1. Download TrueCrypt. 
2. Run the installer. 
3. When prompted, select Extract and click Next. 

http://www.truecrypt.org/downloads.php�
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4. Extract the files to your USB key drive in a folder 
named TrueCrypt. 

Figure 7: TrueCrypt Files 
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You can delete other files in the directory if you wish. 
Ensure you keep the four files as depicted above (Figure 
7.) 

3.5.2 Encrypt part of your USB drive 

1. Run TrueCrypt.exe. 
2. Once loaded, specify a drive letter that will become 

the encrypted volume (the drive letter of your USB 
drive won’t change—but will show as two different 
drive letters when you complete this tutorial.) 

3. Click Create Volume. Your USB drive will still keep 
its letter (e.g., “R”), but it will be split into two 
virtual drives (so the encrypted data will appear as 
a “[your chosen letter]” drive in Computer after you 
finish the setup.) 

4. Now click Create a standard TrueCrypt volume and 
click Next. 

5. The next screen will ask you where you want to 
store the volume. Save a file named Container in 
the TrueCrypt folder on your USB thumb drive and 
click Next. 
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6. Specify the size of the encrypted volume (I suggest 
you use 1/2 the size of the drive.) 

7. Create a secure password. 
8. Now click Format and your Container will be 

formatted. 
9. After a confirmation message, click Exit. 

3.5.3 Verify Your Encrypted Drive Works 

1. Go to your Computer and look for a “W” (or letter 
you chose) drive. It’s not there; good news! 

2. Open TrueCrypt. 
3. Click the drive letter you chose in the previous 

steps. 
4. Click Select File and find your Container you 

created. 
5. Click Mount. 
6. Type in your password and click OK and your 

volume will mount. 
7. Go to Computer and your drive will be there. 
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When you are done, go back to TrueCrypt and click 
Dismount. Congratulations, you now have your data 
encrypted on your USB drive. 

3.6 Protect Your Data in a Hidden 
Container 

If you want to protect the files on your computer in an 
easy way, Secret Disk provides a great solution. Please 
note: if you are trying to protect your files from a customs, 
or similar, inspecition, you may be required to enter your 
password. Thus, using a program like this is not a solution 
to hiding illegal information–don’t do it! 

To set up your secret container: 

1. Download Secret Disk. 
2. Install Secret Disk on your computer. 
3. Start the program and select a password. 

http://privacyroot.com/software/SEDE-download.php�
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4. Secret Disk creates a partition for your hidden files 
(note: if you already have the X drive mapped on 
your network, like I have, Secret Disk will replace 
this mapping until you close the program.) 
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5. Now you can store your files on this partition. 
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6. Lock your disk when you are finished with it. 

 

7. Now the disk is locked, it cannot be accessed. 
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8. To unlock the secret partition, just start the 
program, click unlock, and type in your password. 
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9. You can delete your secret disk at any time. 
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This program is an excellent solution for anyone who is 
looking to protect sensitive files. 

3.7 Maximize Privacy: Browser Ad 
Blocking 

Let me begin by saying: adverts can be very useful and 
help you find what you are looking for; some ads are 
unobtrusive and inoffensive. However, I personally don’t 
like seeing ads and I always encourage people to block 
them. In this section, you’ll learn how to block ads in IE8*, 
Mozilla Firefox, Opera, and Google Chrome. 

*IE has no supported extension, and your results will vary. 
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3.7.1 Internet Explorer 8 

To block ads in Internet Explorer: 

1. If you haven’t already, upgrade to version 8. 
2. While browsing, click Safety > InPrivate Browsing 

(CTRL+SHIFT+P.) 

 

3. You will be notified InPrivate browsing is running.  

http://www.microsoft.com/windows/internet-explorer/worldwide-sites.aspx�
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4. Over time, InPrivate will build a list of content that 
should be blocked and you will see less ads.  

If you'd like to speed up the process, see this discussion 
on importing AdBlock definitions to InPrivate. 

3.7.2 Mozilla Firefox 

To block ads in Mozilla Firefox: 

1. Download AdBlock Plus. 

http://mintywhite.com/forum/viewtopic.php?f=15&t=1728�
https://addons.mozilla.org/en-US/firefox/addon/1865�


Windows 7 – The Pocket Guide 90 
 

 

 

2. When prompted, select EasylistUSA as your 
subscription 

3. Enjoy ad-free browsing! 

3.7.3 Google Chrome 

To block ads in Google Chrome: 

1. Go to the AdSweep site. 

http://www.adsweep.org/�
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2. Follow the instructions for Google Chrome (these 
are subject to change and better referenced than 
replicated.) 

3.7.4 Opera 

To block ads in Opera: 

1. Go to the AdSweep site. 
2. Follow the instructions for Opera (these are subject 

to change and better referenced than replicated.) 

3.7.5 Safari 

To block ads in Safari: 

1. Download Safari AdBlock. 
2. Install the software and enjoy ad-free web 

browsing 

http://www.adsweep.org/�
http://download.cnet.com/Safari-AdBlock/3000-2378_4-10793198.html�
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3.8 Maximize Privacy: Windows Media 
Player 11 

Personally, I like to ensure maximum privacy when using 
my computer. There are many programs that gather and 
send data; however, I will focus on Windows Media Player 
11 because this is bundled with Windows 7. This section 
will show you how to ensure maximum privacy in Windows 
Media Player 11 (WMP11.) Microsoft, in the interest of 
privacy, allows you to protect your data; this section shows 
you how to do this. 

3.5.1 Configuring Privacy When Setting up 
WMP11 for the First Time 

To configure privacy settings, when setting up WMP11 for 
the first time: 

1. a. Click on the Windows Media Player icon on the 
Taskbar. 
b. OR click the Start button, type Media, and click 
Windows Media Player.) 
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1. Click Custom Settings and click Next. 

 

2. Adjust the privacy options accordingly. Review the 
screenshot, below, for my recommendations. Click 
Next. 
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3. Choose whether or not to make Windows Media 
Player your default media player. Click Finish. 
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Your privacy is now protected when viewing and listening 
to media. 

3.5.2 Configuring Privacy after WMP11 is Set 
Up 

To configure privacy settings, after WMP11 is already set 
up: 
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2. a. Click on the Windows Media Player icon on the 
Taskbar. 
b. OR click the Start button, type Media, and click 
Windows Media Player.) 

 
3. On the Windows Media Player screen, Press the Alt 

key, and click Tools > Options… 

 

4. Under the Privacy tab, configure your privacy 
settings. Review the screenshot, below, for my 
recommendations. Click OK. 
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Your privacy is now protected when viewing and listening 
to media. 



 

 

4 Windows 7’s New Features 

Windows 7 is packed with a whole host of new features. In 
this chapter, we’ll take a look at some of these new 
features and how they can help you work more efficiently 
on your computer. While this is not an exhaustive break 
down of each feature, my hope is to both bring awareness 
of what Windows 7 has to offer and inspire you to make 
the most of what is available. 

Some of these features are explained in more detail later 
in this book. 

4.1 Libraries 

Libraries are special folders, which aggregate your current 
media folders into one. For example: if you have three 
video folders (e.g., Movies, TV Shows, and Camera Videos), 
you can merge them into one, and have quick access to all 
your files at once. Public folders will also be merged into 
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your libraries so your whole network can have seamless 
access to public files. This feature is particularly useful if 
you have a home media server and want to access the 
media on the server without navigating to mapped drives. 

Figure 8 shows the Libraries view, which gives you quick 
access to your documents, music, pictures, videos, and 
more. 

Figure 8: Windows 7’s libraries 

Figure 9 shows an example of a library, which contains two 
different folders. A library can contain many folders from 
different locations including network locations.  



101 4 Windows 7’s New Features 
 

 

Figure 9: Libraries can contain many different folders 

4.2 AeroSnap and AeroPeek 

AeroSnap and AeroPeek are two features, which help you 
work more efficiently in Windows 7. Both features work 
with Aero enabled; however, AeroPeek will not work if Aero 
is disabled.  

4.2.1 AeroSnap 

AeroSnap is used to “dock” your windows to a side of the 
screen. If you’ve ever wanted to compare two windows 
side by side, this is the feature you’ve been waiting for.  

Simply drag the window you are using to the left or right 
hand side of the screen. The window will then “snap” to 
that side of the screen, as shown in Figure 10. You can 
also drag a window to the top of the screen to maximize it. 
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Figure 10: AeroSnap “snaps” your windows to screen edges 
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4.2.2 AeroPeek 

AeroPeek helps you take a “peek” at your desktop by 
moving the cursor to the bottom, right-hand side of the 
screen. This feature helps you regain focus. I’ve not found 
this feature as useful as AeroSnap, but I am sure the idea 
will grow on me and I will find myself using it more often 
as I become more familiar with it.Figure 11 shows an 
example of AeroPeek in action. 

Figure 11: AeroPeek lets you “peek” at your desktop 
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4.3 Federated Search 

Federated search is used to search beyond 
the scope of your PC. Based upon 
OpenSearch and RSS, you can search 
remote repositories. You can create your 
own connectors, which is very easy 
because of the standard format used by 

OpenSearch. Figure 12 shows the Live Search connector 
after installation; you can now use Live Search directly 
from Windows Explorer. 
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Figure 12: Use Federated Search connectors 

4.4 Improvements in User Account 
Control 

One of Windows Vista’s most criticized features is User 
Account Control (UAC.) Things need to be simple when 
using your computer and UAC seemingly added a new 
level of complexity that rarely helped the average user. 
Yes, asking a user if they want to take a specific action 
does add a level of security; however, if the user is clicking 
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yes to everything, then this level of security becomes more 
of a stumbling block. 

Microsoft listened to users and has greatly improved UAC. 
For example, the default user in Windows 7 (the one you 
set up when you installed Windows) has the setting 
enabled whereby self-made changes to Windows settings 
do not need a prompt. However, changes made by 
programs still need approval. Figure 13 shows the details 
of this setting. With this setting, only warnings are given 
when changes to the computer are requested by software. 

Figure 13: Default UAC Setting 
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To access UAC settings: 

1. Click the Start button, type UAC, and click on 
Change User Account Control Settings. 

2. Currently, there are four options are offered when 
deciding on the level of security set by UAC. These 
options are range from Never notify to Always 
notify. 

Microsoft isn’t the only one that made changes; other 
companies have built their software to work with UAC so 
there will be fewer compatibility issues as Windows 7 
matures as an operating system. 

4.5 BitLocker To Go and Biometric 

BitLocker encrypts your drives so others cannot access 
them without a password. Two new and exciting features 
in Windows 7 are BitLocker To Go and BitLocker Biometric. 
The following is an explanation of both of these features: 
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4.5.1 BitLocker To Go 

BitLocker To Go encrypts the data on your portable media. 
With an increasing number of key drives at our disposal, 
loss of sensitive data is becoming more of a threat. In this 
section, you’ll learn how to encrypt your thumb (flash) 
drive with BitLocker To Go (Alternative: Encrypt your USB 
Drive’s Data), how to verify that the data is encrypted, and 
how to remove encryption from your drive. 

4.5.1.1 Encrypting Your Thumb Drive 

To encrypt your thumb drive: 

1. Plug your thumb drive into a USB port. 
2. Click the Start button, type BitLocker, and click on 

BitLocker Drive Encryption. 
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3. Next to your thumb drive icon, click Turn on 
BitLocker. 

 
4. If your thumb drive is compatible, BitLocker will 

prepare it for encryption. 
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5. Choose a password and click Continue. 
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6. Either save your recovery key (used if you forget 
your password) or print a copy of it. 
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7. If you save the file, ensure the file is stored 
somewhere safe. 

 
8. Click Next. 
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9. Confirm your chosen settings and password and 
click Start Encrypting. 

 
10. Your drive will now be encrypted. 
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If you have a large thumb drive, this can take a long time. 

 

4.5.1.2 Verifying That Your Data is Encrypted 

When protecting your data or anything you own, it is 
important to ensure the protection actually works. I took 
my thumb drive out of the Windows 7 machine and put it 
in a Vista machine. You should do the following too, to 
ensure your data is protected. 

Please note: If you check the drive in an older version of 
Windows, you will need either XP SP3 or Vista SP1 (or 
above) to read the encrypted drive. Other operating 
systems will recognize the drive as an unformatted drive. 
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To verify that your data is protected: 

1. Put your thumb drive in another PC and try to open 
the files. You should see a BitLocker setup file, 
which shows BitLocker is not installed on the 
computer you’re testing on. If you have BitLocker 
installed on the machine, you will be prompted for 
a password (see the next step.) 

 
2. If you have BitLocker installed on the PC you are 

testing on, you will be prompted for your 
password. If it’s not installed, go ahead and install 
it. 
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3. Enter your password to get to your data. 

4.5.1.3 Removing BitLocker Encryption 

If you would like to decrypt your drive: 

1. Plug your thumb drive into a USB port. 
2. Click the Start button, type BitLocker, and click on 

BitLocker Drive Encryption. 
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3. Next to your thumb drive, click Turn Off BitLocker, 
and click Decrypt Drive. 

 
4. You should be notified your data is decrypting (this 

will take some time.) 

 
5. Your drive is no longer encrypted. 

Now you are familiar with Windows 7’s built-in feature, 
BitLocker To Go, which helps you protect your data. 
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4.5.2 BitLocker Biometric 

BitLocker Biometric protects your computer by fingerprint 
credentials. If you don’t have a fingerprint scanner on your 
laptop, I am sure, by now, you’ve seen someone with a 
laptop that has this functionality. BitLocker Biometric 
provides native support for logon authentication for 
Windows and also comes with an API software vendors can 
use to protect access to programs. Expect to see more and 
more programs using this feature. Figure 14 shows a list 
of biometric devices attached to your computer.  

 

Figure 14: List of Biometric devices 

You can assign any finger when enrolling a biometric 
device as shown in Figure 15. 
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Figure 15: Assign a finger to your biometric device 

BitLocker biometric looks to be an exciting feature that will 
become more integral to our computing habits in the near 
future. 

4.6 The Windows HomeGroup 

Setting up a home network can, at times, be complicated. 
In the past, Windows XP and Vista haven’t done a great job 



Windows 7 – The Pocket Guide 120 
 

 

at guiding you through the setup process. As the average 
household has more than one computer these days (no 
source, but I’m just assuming this is the case), home 
networking is becoming more of a mainstream need. With 
PCs running Windows 7, a home network is easier to setup 
and a lot more useful. HomeGroup makes it easier to 
connect to other computers and devices on a wireless 
home network, so you can share files, photos, music, 
printers, and more throughout your home network. 
HomeGroup is strictly a feature of Windows 7, so you’ll 
need to have at least two PCs running Windows 7. Once 
you've set up a HomeGroup, you can use the Network and 
Sharing Center to choose what you share with other 
HomeGroup members. 

4.6.1 Set up Your HomeGroup 

Figure 16 shows the location specification of the current 
network you are connected to. When you select Home as 
your network locationn (after connecting to your network), 
Windows will start modifying settings to enable resource 
sharing. 
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Figure 16: Selecting the location of your network 

After Windows prepares your network, you will be asked to 
decide what you want to share on the network. Choose 
from Pictures, Documents, Printers, Music, and Videos 
(Figure 16.) When you click Create Now, your network will 
be set up with the choices you made (Figure 17.) 
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Figure 17: Selecting shared items for your HomeGroup 

Now your HomeGroup is nearly set up. All you need is the 
password, which allows other computers, running 
Windows 7, to connect to your HomeGroup. Figure 18 
shows the screen where you are given your password. You 
can view this password whenever you need by going to the 
Network and Sharing Center. 
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Figure 18: Your HomeGroup password 

4.6.2 Joining Your HomeGroup with Another 
PC 

Now you’ve set up your HomeGroup, you can join other 
computers to it. To join your current HomeGroup, go to 
your second PC and: 

1. Connect to the same network (wireless or wired) on 
which the current Windows 7, HomeGroup-enabled 
PC is connected. 
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2. You will be prompted to join the HomeGroup. Click 
Join Now. 

 
3. Type in your HomeGroup password 
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4. Now you can decide what you would like to share, 
from your PC, on the HomeGroup 

 
5. After sharing your files, your PC is now part of the 

HomeGroup.
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4.6.3 Accessing Files Shared on the 
HomeGroup 

To access files shared on your HomeGroup: 

1. Open Windows Explorer (+E.) 
2. In the left-hand pane, you should now see your 

HomeGroup files. Click on the links to access the 
shared data. 
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4.7 Device Stage 

Device Stage is a new technology that helps you interact 
with any compatible device connected to your computer. 
Device Stage lets you see device status and run common 
tasks. This a current list of products that take advantage 
of Device Stage. 

Device stage is designed to take the pain out of adding 
new devices to your computer and have them working 
almost instantly. Many people wonder why it is so hard to 
recognize a device plugged into a machine. Simply put, 
Windows cannot interact with all these devices instantly 
because they all work differently; Windows needs drivers 
for these devices to communicate with them properly. 
Device stage will install drivers when you plug a new 
device in or go out to Windows Update to get the 
necessary files. I am very impressed with Device stage. I 
plugged in my LG TV and not only did it recognize it as 
such, but it changed my PC’s resolution to the TV’s native 
resolution of 1920 x 1080 without me clicking the mouse 
once. 

http://www.microsoft.com/windows/windows-7/devices.aspx�
http://www.microsoft.com/windows/windows-7/devices.aspx�
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Essentially, device stage should alleviate the need for bulky 
third-party applications that were required, in the past, to 
access your devices. 

4.8 Action Center 

Windows Action Center is an improved version of Vista’s 
Security Center. The action center alerts you to problems 
with your PC and lets you know how you can resolve them. 
Notifications are delivered through the notification area 
(Figure 19.)  
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Figure 19: Action Center notifications 

Figure 20 shows the action center, which gives you alerts 
about virus protection settings, Windows update, and 
more. 
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Figure 20: The Windows Action Center 

The Action Center deals with both security and 
maintenance. 

4.8.1 Action Center – Security 

The security section of the Action Center deals with anti-
virus software and spyware protection, firewall settings, 
UAC, and more. This is your one-stop solution to ensuring 
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your computer is secure. Figure 21 shows the settings that 
are monitored. 

Figure 21: Action Center - Security alerts 

4.8.2 Action Center – Maintenance 

In a similar fashion to the security section, the Action 
Center also ensures your computer is maintained and 
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deals with backup, updates, and more. Figure 22 shows 
the areas the Maintenance section is responsible for. 

 

Figure 22: Action Center - Maintenance alerts 

4.8.3 Action Center – Troubleshooting 

One great feature bundled with the Action Center is 
troubleshooting. If you are having problems with your 
computer, open the troubleshooting component and 
Windows will run tests to determine why the problem 
exists and how it can be fixed. 
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To test the troubleshooter, I decided to let Windows find 
out why I cannot run Aero in a virtual environment. To 
troubleshoot a problem: 

1. Click the Start button, type action, and click on 
Action Center. 

 
2. Scroll down and click on Troubleshooting. 

 
3. Click Yes if you would like to get the latest 

troubleshooting updates. 
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4. Locate the issue you are having (in this case: 
Display Aero desktop effects.) 

 
5. Windows will now determine why you are having 

the problem. 
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6. In this case, Windows determined I need to update 
my drivers. 
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7. Windows may continue to detect problems. 

 
8. Windows has found the exact problem: my graphics 

card (a generic VMware card) is not compatible with 
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Aero. 

 

The Action Center is great and a move in the right 
direction. Computers will never completely fix themselves, 
but letting you know what the problem is helps greatly. 

4.9 Internet Explorer 8 

Internet Explorer 8 is Microsoft’s latest web browser, 
which comes packed with many new features. Below is an 
explanation of how to get IE8 up and running and a 
breakdown of some of the best features. 
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4.9.1 Configuring IE8 for the First Time 

When you first launch IE8, you are presented with some 
questions. I’ve put together a simple step by step and 
explanation of the initial setup: 

1. Click on the IE8 icon on the Taskbar. 
2. You will see the initial setup screen. Click Next. 

 

3. Choose whether you want suggested sites or not. 
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4. I recommend choosing Custom Settings. 
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5. If you want a custom provider, click Show me a 
webpage after setup to choose more search 
providers. 
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6. If you want to set up more accelerators, click Show 
me a webpage after setup to choose more 
Accelerators. 
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7. Smart Screen Filter helps protect you from 
malicious websites. 
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8. You can choose to use compatibility updates. 
These updates make websites, designed for older 
browsers, look better. 
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9. Click Finish and you are ready to go. 

4.9.2 Web Slices 

Web slices are used to save ‘snippets’ of your favorite web 
pages and show you just the parts you want to see. These 
can be really useful when you follow some websites that 
are updated frequently. See the selection of Web Slices 
here. 

http://www.ieaddons.com/en/webslices/�
http://www.ieaddons.com/en/webslices/�


145 4 Windows 7’s New Features 
 

 

An example of a Webslice: MSN News Slideshow: 

 

4.9.3 Accelerators 

Accelerators help you perform common tasks, such as 
online search and mapping, with ease. Download 
accelerators here and install the ones you want to use. 
Then, when you are browsing, simply highlight some text 
and click the accelerator arrow to perform a task. 

http://www.ieaddons.com/en/accelerators/�
http://www.ieaddons.com/en/accelerators/�
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Adding new accelerators is easy; click the accelerator you 
want and click Add. 

 

4.9.4 Quick Tabs 

Quick tabs show you all currently open tabs at a glance to 
help you select the page you need. 
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4.9.5 Improved Search 

Search has been greatly improved, with smart suggestions 
and even inline search (absence of a pop-up search 
window)—a feature I’ve taken for granted in Firefox. 

Enter your query in the search bar and receive customized 
results and suggestions depending on the current search 
engine in use. 
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Inline search helps you find the key phrases you are 
looking for, without the hassle of a pop-up search box. 

 

4.9.6 InPrivate Browsing 

InPrivate Browsing helps prevent Internet Explorer from 
storing data about your browsing session. This includes 
cookies, temporary Internet files, history, and other data. 
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Toolbars and extensions are disabled by default. 

 

4.9.7 Automatic Crash Recovery 

If IE8 crashes while you are using it, you won’t lose your 
current tabs; IE8 recovers your browsing session 
automatically. 
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4.10 Geographic Location 

Many programs in Windows 7, such as Firefox, will utilize 
your geographic location. This location will be used in a 
variety of ways including letting people know where you 
are when you send emails and take pictures, etc. 

To set your default geographic location: 

1. Click the Start button, type loc, and click on Default 
Location. 

2. From this screen, you can set your default location 
settings. 
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3. When you are done, click Apply. 

Now you are ready for maximum utilization as more 
location-aware programs and services are released. 
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4.11 Conclusion 

Windows 7 has some excellent new features. Yes, there are 
even more new features than I previously listed in this 
chapter; however, I feel ones I’ve covered are the most 
exciting and useful. 

Windows 7 is Microsoft’s best operating system to date; I 
am in no doubt about this statement. The future is bright. 

 



 

 

5 System Maintenance and 
Management 

Just like any car, Windows needs to be maintained and 
cleaned frequently. Whenever I work on someone’s 
computer, I have a check list of things I like to do to 
ensure I won’t be working on the same computer anytime 
soon. 

Anyone can maintain their computer; they just have to 
learn how. In this chapter you’ll learn some basic tips and 
about some tools to use—to ensure your computer 
becomes/remains clutter free and does not get sluggish. 

5.1 Automatically Delete Temporary 
Files 

The Windows Disk Cleanup Wizard will delete your 
temporary files, but only if they are over a week old. To 
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create a simple batch script that will clean up your 
temporary directories: 

5.1.1 Create the Batch File 

Open Notepad and type (ensure you have two lines as 
shown below): 

cd C:\Users\%username%\AppData\Local 
rmdir /S /Q Temp 

 

Save the file as cleantemp.bat 
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Now double click on the file, you created, to remove your 
temporary files and free up space on your computer. 

If this doesn’t work and gives an access error, try replacing 
%username% with you windows login username. 

5.1.2 Automate the Process 

To automate this process:  

1. Right click on the batch file you created and click 
create shortcut. 

2. Place the shortcut in your startup folder in the start 
menu (Customize Your Start Menu.)  

3. Now when you log in to Windows 7, your temporary 
files will be deleted. 
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5.2 Clean up Windows 

Cleaning up Windows can be a tedious task as there are so 
many temporary and unused files stored everywhere. 
Manual cleaning may be more thorough, but would take 
hours. Luckily there are two programs suited to this job.  

The first of these two programs is the well known 
CCleaner. CCleaner is a freeware system optimization, 
privacy and cleaning tool. It removes unused files from 
your system—allowing Windows to run faster and freeing 
up valuable hard disk space. It also cleans traces of your 
online activities such as your Internet history. Additionally 
it contains a fully featured registry cleaner. 

Another program I use frequently is Advanced SystemCare 
Free (ASC.) ASC is a comprehensive PC-care utility that has 
a one-click approach to helping protect, repair and 
optimize your PC.  

I prefer ASC but CCleaner is great too. You do not need 
both of these programs; one of these programs is 
adequate. 

http://www.ccleaner.com/download�
http://www.iobit.com/advancedwindowscareper.html�
http://www.iobit.com/advancedwindowscareper.html�
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5.3 Remove Entries from Add/Remove 
Programs 

There may be several reasons for removing certain 
programs from the add/remove programs list. One reason 
may be that you have no intention of removing some 
programs and they are cluttering the list—or you may want 
to remove that net monitoring program so your kids can’t 
remove it. In this section you will learn how to remove 
these programs. 

I recommend you back up the Windows Registry before 
doing this. 

1. Open the Registry Editor (Appendix D: Launch 
Windows Registry Editor.) 

2. Scroll to the following entry: 

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Curr
entVersion\Uninstall 



159 5 System Maintenance and Management 
 

 

 

 

3. In the left pane are the programs (some 
represented by numbers and letters, and some by 
their name) and in the right pane you can see the 
display name. 

4. Find the key that corresponds to the program you 
want to hide. Click the key in the left pane and click 
File > Export. 
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5. Choose a name for the file and save it. (This will 

allow you to restore the key when you want to 
uninstall the program.) 

 

6. Now the key is backed up, you can delete the key 
by right clicking on it and choosing Delete. 

7. Restore the key by double clicking on the reg file 
you saved in step 5. 
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5.4 Remove Unwanted Software 

I advise you to browse your add/remove programs list and 
weed out any software you do not use. This will free up 
hard drive space and cut down clutter on your PC. 

If you have a newer PC, there may be a lot of trial software, 
coined “bloatware”. The PC Decrapifier is designed to 
remove a specific list unwanted software in an unattended 
fashion. The PC does not need to be new; however, the 
older the PC is, the less likely it will have any of the 
software it can detect. 

Simply download PC Decrapifier, and run the EXE. There is 
no installation necessary. If you have anti-virus software 
installed, it may complain about this program; these 
warnings can be safely ignored. 

When it runs, you will be presented with a wizard-style 
dialog box that steps you through the entire process. 

You will be able to pick and choose what programs you 
want to remove. The program will not remove anything, 
without prompting you first. 

http://www.pcdecrapifier.com/download�
http://www.pcdecrapifier.com/download�
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Click the Next button and it will begin cleaning your PC. If 
it does not find anything, a pop-up box will notify you of 
this and the program will exit and not modify your PC. 

5.5 Disable Memory Dump Files and 
Save HDD Space 

If your computer crashes, it will create a dump file. From 
this dump file you can diagnose the source of the problem. 
It is unlikely you will need this file; if you do, you can 
always turn the option back on. This section will show you 
how to save space by disabling memory dump files in 
Windows 7. 

1. Click Start and click Control Panel. 
2. Type Advanced in the search box. 
3. Click on View advanced system settings in the 

search results. 

 
4. Under Startup and Recovery, click Settings. 



163 5 System Maintenance and Management 
 

 

 

5. In the Write debugging information drop down, 
click (none) and click OK. 
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6. You will now save space and not store (possibly) 
useless information. 
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5.6 Shrink/Extend a Partition on Your 
Hard Drive 

If you use multiple partitions on your hard drive, you may 
want to shrink or extend one of them—after realizing you 
want more space on another one of the partitions. (Create 
a New Partition.) 

1. Click the Start button, right click on Computer, and 
click Manage (the Computer Management Console 
will load.) 
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2. In the left pane, click Storage > Disk Management. 

 
3. All disks and partitions will display. To shrink a 

partition, right click on the partition and choose 
Shrink Volume. 
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4. Enter the amount of space, to shrink by, in MB. 

 
 

 

If you would like to extend a partition, you will need to 
make sure there is empty space available behind the 
partition. Then go back to step 4 and instead click Extend 
Volume.  
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5.7 Schedule Defragmentation 

Defragmentation helps speed up access to data on your 
drive. In this section, you’ll learn how to schedule 
defragmentation so you don’t have to worry about 
ensuring your drive is defragmented. 

5.9.1 What does “Defragment” mean? 

When you constantly add and delete files on your hard 
drive, they become fragmented. 

Think of this as follows: You have a library full of 
collections of books. Each of these collections represents a 
file on your hard drive. You take one book from the 
collection and put some sticky notes in the book and make 
it too big to fit back on the shelf–so you put it on the end. 
Every now and then you get a new book for a collection; 
these too need to go on the end of the shelf. You sell a 
collection and buy a bigger one to replace it. 
Unfortunately, the whole collection doesn’t fit in the 
recently made space so you put half in the space and half 
at the end of the shelf. You do this for years and you have 



169 5 System Maintenance and Management 
 

 

a mess on your hands. Defragmenting “re-orders your 
book collections” in terms of your data, and makes access 
to them a lot easier. 

5.9.2 Setting up Scheduled Defragmentation 

Setting up scheduled defrags is easy: 

1. Click the Start button, type defrag, and click Disk 
Defragmenter. 

 
2. Click Configure schedule. 

 

3. Choose a time when your computer is turned on, 
but you are not using it. 
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4. Click OK and Close to save your settings 

Your disk will now be defragmented regularly. 

5.8 Take Charge of Automatic Updates 

If you leave your computer on overnight, you may find you 
come back in the morning to find all your programs closed 
and that download, you were waiting for, canceled. Likely, 
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automatic updates restarted your computer or you had a 
short power outage. In this section, we’ll blame automatic 
updates and learn how to disable automatic installation of 
the updates. 

Automatic updates will let you choose different options: 

• Install updates automatically. 
• Download updates but let me choose whether to 

install them. 
• Check for updates but let me choose whether to 

download and install them. 

• Never check for updates. 

To configure automatic updates: 

1. Click the Start button and click Control Panel. 
2. Click System and Security. 
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3. Click Turn automatic updating on or off. 

 
4. Choose your preferred method of updating your 

computer. 

 

5. Click OK. 

Now, when updates are available, you will not necessarily 
have to install them instantly. 

 



 

 

6 Increase Performance 

Windows runs pretty well on its own. I am very impressed 
by how well Windows 7 works out of the box, but there are 
still a few things you can do to improve performance. 

I could write many books on all the tweaks you can apply; 
however, in this chapter I will focus on the key things you 
can do to get the most performance out of doing the least 
work. 

As always, I recommend you make backups before making 
major changes to your system: 

• Appendix C: Create a System Restore Point 
• Appendix E: Back up the Windows Registry 
• Back up Your Data 
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6.1 Reduce Boot Time 

Does your computer boot slowly? If you shut your 
computer down regularly, this can be a real pain. Anything 
more than about 45 seconds tests my patience and I’ve 
used computers that take well over five minutes to boot 
(really, not kidding.) 

There are three easy things you can do to improve boot 
time: 

• Remove unnecessary startup programs. 
• Delay non-essential programs on startup. 

• Remove Spyware. 

In this section, you will learn how to do the first two of 
these tasks. 

6.1.1 Use Startup Delayer to Reduce Boot Time 

Some programs need to start right away, 
like your dock or your antivirus 
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program. Some programs can wait; for example: 
Messenger programs, etc. 

With StartUp Delayer, you can set programs to start up in 
defined intervals, which will smooth the startup process 
considerably. The program also acts as a startup manager, 
allowing you to uncheck programs you don’t want to run 
at all. 

Figure 23 shows Startup delayer’s interface, which lets you 
drag programs to the delay area. Once in the delay area, 
you can define how long to wait before these programs 
start. 

http://www.download.com/Startup-Delayer/3000-2094_4-10068235.html�
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Figure 23: Startup Delayer's interface 

After testing this software on my Windows 7 Ultimate 
laptop (Core Duo 2 GHz, 3 GB ram), I managed to get a 
complete startup time (boot to functionality) in 28 seconds 
(originally 41)… not bad. I have done other things to tweak 
my laptop, but this is still a real improvement. 
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6.2 Rate and Improve Your Computer’s 
Performance 

Like Windows Vista, Windows 7 comes with a performance 
rating tool, which rates your system and then gives you 
tips on improving it. In this section, you’ll learn how to use 
Windows 7’s Performance Information Tools to rate your 
system. 

To rate your system: 

1. Click the Start button, type perf, and click on 
Performance Information and Tools. 

2. Click on Rate this computer and let the tests run. 

 
Windows will now rate your computer. This rating can take 
up to 20 minutes (Figure 24.) 
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Figure 24: Rating Computer Performance 

After the test is complete, Windows will offer suggestions 
on how to improve your computer’s performance (Figure 
25.) 

Figure 25: Windows Scores Your Computer Based on 
Performance 
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6.3 Enhance SATA Disk Performance 

You can improve the performance of your SATA hard drive 
by enhancing write caching. 

If you are not sure whether or not you have an SATA drive 
in your computer, please check with your manufacturer. 

A quick warning: If you turn this setting on and your 
computer is not connected to a battery backup, losing 
power increases you risk of data loss or corruption. If you 
are using a laptop, the chances of this are unlikely as you 
have a battery in the laptop that will act as a power source 
if there is an outage. 

To enhance SATA drive performance: 

1. Click on the Start Button, type dev in the search 
box, and click Device Manager. 
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2. Click on the + Next to Disk Drives 

 
3. Right click on your hard drive and click Properties. 

 
4. Click the Policies tab and check Enable advanced 

performance (Note: this option may not be 
available for your drive.) 
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5. Now click OK and close Device Manager. 

6.4 Speed up Your External Hard Drives 

The default setting in Windows 7 disables write caching for 
external drives. This is done so that you can remove an 
external drive at any time without data loss. If you are 
willing to eject your drive each time using Safely Remove 
Hardware, you can increase the performance of your 
external hard drives by enabling write caching. 

To turn write caching on and activate advanced 
performance: 

1. Click on the Start Button, type dev in the search 
box, and click Device Manager. 

 

2. Click on the + Next to Disk Drives. 
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3. Right click on your external hard drive and click 
Properties. 

 
4. Click the Policies tab and click Optimize for 

performance. 

 

 



183 6 Increase Performance 
 

 

5. If available, check: Enable write caching on the 
device and Turn off Windows write-cache buffer 
flushing on the device. 

6. Click OK. 
7. Reboot your computer to apply changes. 

6.5 Use ReadyBoost to Speed up 
Programs 

Using Windows ReadyBoost is a great way to improve the 
performance of your computer when doing your day-to-
day tasks. 

6.4.1 What is ReadyBoost? 

ReadyBoost uses a USB thumb drive to create an extra 
cache of the most commonly used data, which is quickly 
accessible when needed. Microsoft’s website states: 

Windows ReadyBoost [is] a new concept in adding 
memory to a system. You can use non-volatile 
flash memory, such as that on a universal serial 
bus (USB) flash drive, to improve performance 
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without having to add additional memory "under 
the hood."  

Source 

6.4.2 How Does ReadyBoost Work? 

Solid state memory (what your USB drive uses) has 
excellent transfer speeds; therefore, it can be used to 
store and access data that is needed quickly. 

Windows 7 ReadyBoost uses the USB thumb drive as an 
extra cache between the processor and the hard disk. 
Unlike RAM, the data is stored on your thumb drive and 
can be used next time you use your computer—a great 
time saver if you use many different programs and run 
many of them simultaneously.  

6.4.3 What are the Requirements for 
ReadyBoost? 

For a USB thumb drive to be compatible, it needs to have a 
minimum of 256 MB free space. Most modern USB thumb 

http://www.microsoft.com/windows/windows-vista/features/readyboost.aspx�
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drives will meet the space and speed requirements of 
ReadyBoost. 

6.4.4 How Can I get ReadyBoost Working for 
Me? 

To enable ReadyBoost: 

1. Put your USB thumb drive into a USB port on your 
computer. 



Windows 7 – The Pocket Guide 186 
 

 

2. When the AutoPlay menu appears, click Speed up 
my System with Windows ReadyBoost. 

 
3. Select your device and specify how much of the 

drive you want to use for ReadyBoost. I recommend 
using a full USB drive. (TIP: match the size of your 
drive to the amount of RAM you have in your 
computer. i.e., With 4GB RAM, use a 4GB thumb 
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drive.) 

 
4. Click OK. Don’t expect miracles—but stick with it 

and your computer will begin to perform more 
efficiently. 
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6.6 Make Windows Shut Down Faster 

As you install programs on your computer, it slows down—
we all know that. However, what you may not know is that 
the programs install services. Windows is “kind” enough to 
patiently wait for these services to stop when you shut 
down your computer; however, if you have all your work 
saved, there is no need to wait. 

Decrease the time it takes for Windows to shut down by: 

1. Open the Registry Editor (Appendix D: Launch 
Windows Registry Editor.) 

2. You will see a screen like the one below. In the left 
menu, navigate to: 
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HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control  
 

 

3. In the right pane you will see a key called 
WaitToKillServiceTimeout, with a default value of 
12000 (12 seconds.) 

4. Right click on the key and click Modify… 
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5. Change the value from 12000 to 4000. 

 

6. This can potentially reduce your shut down time by 
8 seconds. 

Please note: I do not advise setting this value to less than 
four seconds because some programs need a few seconds 
to close and you increase the chance of data loss by 
setting this value any lower. 

6.7 Run Memory Diagnostic Tool 

Memory (RAM) can become corrupted and not work 
properly. Usually, a replacement is needed to fix the 
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problem, but before you replace your hardware, you 
should use the Windows Memory Diagnostic tool. This tool 
is available in both Windows Vista and 7. 

To run Windows Memory Diagnostic: 

1. Click the Start button, type mem, and click on 
Windows Memory Diagnostic. 

2. When the Windows Memory Diagnostic screen 
loads, click Restart now and check for problems. 
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3. You computer will restart. 

 
4. The memory diagnostic will run and can take some 

time (up to an hour.) 
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5. Windows will restart and report any errors to you. 
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After sharing this feature with Windows Vista users, many 
of them reported a more responsive system after the test 
and I expect the same results with Windows 7. 

 



 

 

7 Customize Your Start Menu and 
Desktop 

The start menu and your desktop are two of the most 
commonly used elements of Windows 7. Customizing both 
of them can make your computing experience more 
enjoyable and productive. In this chapter, you’ll learn how 
to customize and improve your start menu; you’ll also 
learn how to customize your taskbar, system tray, desktop 
icons, themes, and color scheme.  

When you are done customizing, you can move to the next 
chapter and learn how to save your settings as a theme. 
Remember, more is less with customization, so you don’t 
need to follow this chapter completely. Use this chapter to 
inspire you to add the finishing touches to your system. 
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7.1 Customize Your Start Menu 

The Windows Start Menu is notoriously bloated and often 
confusing—even in Windows 7. There are a couple of ways 
you can customize your start menu to restore order. The 
first is to customize the right-hand panel and the second 
is to organize the programs folder. 

7.1.1 Customizing the Right-hand Panel 

1. Right click on the Start button and click Properties. 

 
2. On the Start Menu tab, click the Customize… 

button. 

 
Here you can change what shows up in the right section of 



197 7 Customize Your Start Menu and Desktop 
 

 

the start menu (Figure 26.) If you don’t use your Music 
folder, why have it linked there? 
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Figure 26: Customize the Right-Hand Panel 
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7.1.2 Customizing the Programs List 

After installing a few programs, your start menu can get 
cluttered. To reduce the number of folders in the left part 
of the menu, consider using folders like ‘Media’, ‘Internet’ 
etc. To customize your Start Menu: 

1. Click the Start button. 
2. Right click on Programs and click Open All  

Users / Open (you’ll need to edit both.) 

 

Once in the Windows Explorer window, you can rename 
folders and put links together as you please. I usually 
delete the shortcuts to readme files, help files, and 
uninstall links as these can all be accessed from other 
places and I rarely use them.
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Before: 
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After: 

 

While the search function is great, it doesn’t hurt to be 
organized. Please be aware that when you uninstall a 
program, it probably won’t remove the link from the start 
menu because you’ve changed the location of the shortcut. 
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7.2 Change Start Menu Power Button 
Action 

The start menu power option is set to Shut Down, by 
default, in Windows 7. In this section, you’ll learn how to 
change this default option. 

To change the default power option: 

1. Right click on the Task Bar and click Properties. 

 
2. Under the Start Menu tab, choose your desired 

power button action. 
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3. Click OK to save 

Test the new setting by clicking the Start button and 
viewing the new option. 

7.3 Change Your Account Picture 

Your account picture is used for the login screen, your 
start menu, windows meeting space, and more. When you 
first set up your account, you can choose one of the 
default images. In this section, you'll learn how to 
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customize your account picture. Do this by following these 
steps: 

1. Click the Start button. 
2. Click your account picture at the top of the menu. 

 
3. In the User Accounts window, choose Change Your 

Picture. 

 

4. a. Either: click a picture you want to use. 
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b. OR click Browse For More Pictures, locate your 
picture, and click Open. 

 

5. If you see any white space around your picture, edit 
it in paint or another editing program to make your 
image square. 

Now you have your own icon for 
your user account. This is really 
helpful when you have multiple 
users on your account. 
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7.4 Customize Desktop Icons 

There are many ways you can customize your desktop 
icons: you can resize them, change them, or even remove 
them. Learn how to customize your icons in this section. 
To customize your icons: 

1. Right click the desktop and click Personalize. 

 
2. Click Change Desktop Icons. 

 
3. Here you can choose the icons you want to be 

shown on the Desktop. 
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To change the default icons: 

1. Follow steps 1-3 from above. 
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2. Click Change Icon. 

 
3. In the Change Icon dialog box, click the image you 

want to replace the selected icon and click OK. 
Note: You can download custom icons here. 

http://mintywhite.com/tech/category/icons/�
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4. Check the icon is the one you want and click apply. 
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5. Go to your desktop to ensure the change took 
place. 

 

To change the size, order, and alignment of your desktop 
icons: 

1. Right click a blank spot on the Desktop, click View, 
and specify the size and alignment of the icons. 

 

2. Choose whether you want the icons to be shown on 
the desktop or to be hidden. 
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You can also resize the icon size on the desktop by 
clicking a blank area on the desktop, holding the Ctrl key, 
and scrolling your mouse wheel. 

7.5 Remove Shortcut Overlay Icon 

 

To remove the shortcut overlay icon in Windows 7 and 
achieve results like the image above depicts: 

1. Download this zip file. 
2. Extract the file and store clear.ico anywhere you 

like. 
3. Open the registry editor (Appendix D: Launch 

Windows Registry Editor.) 
4. Navigate to: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Cu
rrentVersion\explorer\Shell Icons 

http://mintywhite.com/images/forum/clear.zip�
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5. Create a new String value named 29 (Add a New 
Value.) 

6. Double click 29 and enter the path of the clear.ico 
file. i.e., C:\Icons\clear.ico. 

7. Restart your computer to apply changes. 

7.6 Customize Your Mouse 

You're probably pretty happy with how your mouse works, 
but you can always make some changes, which may help 
you. I always turn the sensitivity of my mouse pad up to 
the maximum, which makes me move my fingers less to 
get around the screen. If I want precision, I am unlikely to 
get it with a laptop mouse pad anyway, so I plug in an 
external one. Learn how to customize your mouse in this 
section. 

7.6.1 Set the Mouse Buttons 

To change the behavior of your mouse buttons: 
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1. Click the Start button, type mouse in the search 
box, and click Mouse to display the Mouse 
Properties dialog box. 

 

2. On the Buttons tab, you can switch the mouse for 
left or right-handed use. 

 

3. Move the slider to set the speed at which you need 
to double click for Windows to recognize it. 
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4. When you finish changing the mouse settings, click 
the OK button to save changes. 

7.6.2 Set Mouse Pointer Options 

To change your mouse pointer options: 

1. Click the Start button, type mouse in the search 
box, and click Mouse to display the Mouse 
Properties dialog box. 

2. Click the Pointer Options tab. 

 

3. Here you can set or change the following options: 
• The speed at which your cursor moves. (As 

you move the slider, you can test the effect 
of the change by moving your cursor.) 
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• Increase the precision of the pointer when 
you move short distances. 

• Configure the mouse to automatically move 
to the default button in a dialog box to 
facilitate quick selection of the button. 

• Set the length of the trails if you want to 
increase the cursor’s visibility by 
temporarily showing its path. 

• Remove the cursor's visibility when you're 
typing and not using the mouse. 

• Locate the cursor on your screen by 
pressing the Ctrl key. 

7.6.3 Set Scroll Wheel Options 

Like in Windows Vista, you can configure the behavior of 
the mouse wheel in Windows 7. I use a mouse with a wheel 
most of the time and I frequently utilize the wheel. If you 
too use the wheel, you can find benefit in configuring the 
behavior of it. 

To configure mouse wheel settings: 
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1. Click the Start button, type mouse in the search 
box, and click Mouse to display the Mouse 
Properties dialog box. 

2. Under the Wheel tab, you can configure the vertical 
and horizontal scrolling setting 
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7.7 Add an OS X Style Dock to Your 
Desktop 

Although OS X doesn’t suit my computing needs, I do love 
the look of some of the features it has. One of the best 
features is the easy-to-use and customizable dock. You 
can put a dock in Windows 7 too. To install a dock: 

1. Download ObjectDock here (Go to the page and 
click the “Free Download” button.) 

2. Install ObjectDock on to your computer. 
3. Once installed, launch ObjectDock (if it hasn’t 

launched already.) 
4. You can get thousands of icons for your dock here. 

 

ObjectDock is very easy to use and there is a lot of support 
out there for this free product; go to the ObjectDock 
website and click Forums. 

http://www.stardock.com/products/objectdock/�
http://mintywhite.com/tech/category/icons/�
http://www.stardock.com/products/objectdock/�
http://www.stardock.com/products/objectdock/�
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7.8 Customize the Taskbar 

The Windows Taskbar can be customized to meet your 
needs; you can move it, resize it, hide it, and even add 
toolbars to it. 

7.8.1 Move the Taskbar 

By default, the taskbar resides at the bottom of your 
screen. You can move the taskbar to any side of the screen 
or even to another screen if you use more than one 
monitor. To move the taskbar: 

1. Right click the taskbar and ensure Lock the Taskbar 
is unchecked. 

 
2. Drag the taskbar to the side of the desktop where 

you want it. 
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7.8.2 Resize the Taskbar 

By default, the taskbar is one “row” wide. You can resize 
the taskbar to any size you want (up to half the size of the 
screen!) To resize the taskbar: 

1. Right click the taskbar and ensure Lock the Taskbar 
is unchecked. 

2. Place the cursor on the outer edge of the taskbar 
until the pointer turns into a two-headed arrow. 
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3. Drag the border to change the size of the taskbar. 

 

7.8.3 Auto-hide the Taskbar 

You may find the taskbar gets in the way when you are 
using a program or when you are on working on your 
desktop. You can auto-hide the taskbar when it is not in 
focus. 

To auto hide the taskbar: 

1. Click the Start button, type taskb in the Search 
box, and click Taskbar And Start Menu. 

2. Check Auto-Hide The Taskbar and click OK 
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To access the taskbar, simply move your cursor to the side 
of the screen the taskbar is located on and it will appear. 

7.9 Restore the Quick Launch Toolbar 

Remember the quick launch bar in Windows Vista? This is 
the toolbar with Flip-3D, Show desktop, and IE shortcuts. 
You can have it in Windows 7 too; in this section, you’ll 
learn how to restore this toolbar. 

 

To enable the quick launch toolbar: 

1. Right click the taskbar and click Toolbars > New 
Toolbar… 
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2. Paste the following into the folder field and click 
Select Folder: 

%AppData%\Microsoft\Internet Explorer\Quick Launch 

 

3. Right click the Taskbar and uncheck Lock the 
taskbar. 
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4. TIP: To remove the text, right click the toolbar and 
uncheck Show Text and Show Title. 

 

5. To enable large icons, right click the toolbar and 
click View > Large Icons. 
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You now have your beloved quick launch toolbar back! 

7.10 Add Extra Clocks 

If you spend time in more than one time zone, have family 
around the world, or a really too lazy to work out what 
time it is in Japan, this section is for you. 

To add multiple clocks in Windows 7: 
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1. Click the Clock (lower right-hand side of the screen 
in the notification area) and click Change time and 
date settings… 

 

2. Under the Additional Clocks tab, select up to two 
more clocks. Click OK to save your settings. 
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Now you can see the time around the world: 

 

 



 

 

8 Wallpapers, Themes, and 
Screensavers 

One of the easiest ways to add a personal touch to your 
computer is to change your wallpaper or screensaver. If 
this concept is new to you, then this chapter is for you. If 
you are already familiar with changing your wallpaper and 
screensaver, you can skip these sections, and explore the 
rest of this chapter. 

In this chapter, you will learn how to change your 
wallpaper and make it more functional. You’ll also learn 
how to change your screensaver, and, I’ll point you toward 
some good screensavers you can use on your computer. 
Finally, you’ll learn how to save your settings as a theme 
so you can reuse your customization settings anytime. 
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8.1 Change Your Desktop Wallpaper 

This section will teach you how to change your wallpaper. 
If you are already familiar with this, please move on to the 
rest of this chapter to find out what else you can do with 
your wallpaper and screensavers. 

To change your desktop wallpaper, download one, and: 

1. Right click the desktop and click Personalize. 

 
2. Click Desktop Background. 

 
3. Choose the wallpaper picture or color you want, 

and specify its location. (Note: you can choose 
multiple wallpapers and shuffle them at time 
intervals.) 

http://mintywhite.com/tech/category/wallpaper/�
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• Windows Desktop Backgrounds: to use one 

of the background patterns or pictures that 
came with Windows Vista. 

• Pictures Library: to use a picture from your 
pictures library. 

• Top Rated Photos: To pick your favorite 
pictures by rating. 

• Solid Colors: to use a single color. 
4. Click if Browse you want to locate and use a picture 

from another location. 



Windows 7 – The Pocket Guide 232 
 

 

5. You can specify how your wallpaper will look: 

 
• Fill: Fit to the screen (at the expense of 

some edges that might not fit.) 

• Fit: Ensure the whole picture shows (may 
show black edges if the picture is out of 
proportion.) 

• Stretch: Fits the screen, but may make your 
picture look bad. 

• Tile: Repeat the image across the screen. 
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• Center: A normal sized picture in the center 
of the screen with a solid colored 
background behind it. 

Experiment and see what looks good on your screen. 

8.2 Make Your Wallpaper More 
Functional 

When you think of desktop wallpaper, you probably think 
of a way to express yourself with a picture you really like. 
One suggestion I have, is to make your desktop wallpaper 
more functional by using it in a different way. 

We speak of the main screen of your computer as a 
desktop, but it doesn’t really look like a desktop. 
Download a desktop-like image here and organize your 
files accordingly—just like you would on a physical 
desktop. 

See Figure 27 for a sample of what the wallpaper looks 
like. 

http://flickr.com/photos/gr/182329409/sizes/o/in/set-72157594188036656/�
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Figure 27: Desk Wallpaper 

8.3 Shuffle Desktop Backgrounds 

Windows 7 comes with native background shuffling 
functionality. To enable background shuffling:  

1. Right click the desktop and click Personalize. 
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2. Click Desktop Background. 

 
3. Specify the wallpapers you want to use. 
4. Specify the time interval between transitions 

(Optional: you can Shuffle the order of your 
slideshow.) 

 
5. Click Save Changes and enjoy the slideshow. 

8.4 Activate Hidden Regional Themes  

Windows 7 is a worldwide operating system and Microsoft 
made a really good move by adding regional wallpapers 
into the operating system. When you choose your region 
settings, the appropriate theme is displayed. In this 
section, you’ll learn how to activate hidden regional 
settings in Windows 7. 
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To activate regional themes: 

1. Open Computer (+E), click Organize, and click 
Folder and Search Options. 

 
2. Under the View tab, check Show hidden files, 

folders, and drives and uncheck Hide Protected 
operating system files. 
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3. When prompted, click Yes. Click OK. 
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4. Navigate to %systemroot%\Globalization\MCT\ 

 

5. Select a region by opening its folder and double 
clicking on the theme file to activate the themes. 
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You can now use Windows 7’s “hidden” regional themes 
(Figure 28), which will be available from the Personalize 
menu (right click the desktop and click Personalize.) 

Figure 28: UK Regional Theme 
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8.5 Get More Themes 

Microsoft has a site where you can get more themes. A 
theme can include: wallpaper, cursors, sounds, and 
screensavers. 

To get more themes for Windows 7: 

1. Right click the desktop, and click Personalize. 
2. On the Theme screen, click Get more themes 

online. 

 

You can now browse the website to find new themes. 
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Alternatively, you can go directly to the site here. 

8.6 Save Your Settings as a Theme 

When you are satisfied with the appearance of your 
windows desktop, you can save the settings as a theme. A 
theme incorporates the following settings: 

• Color and appearance choices. 
• Color schemes. 

http://windows.microsoft.com/en-us/Windows7/Personalize�
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• Sound schemes. 
• Mouse pointer schemes. 
• Advanced appearance settings. 
• Screen saver choice. 

These settings are all unique to your account, so things 
like screen resolution, which is a global setting, will need 
manual changing. 

To save your settings as a theme: 

1. Right click the desktop, and click Personalize. 
2. Click Save theme. 

 
3. Give your theme a name 
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You can restore a saved theme, by clicking on the theme 
name under My themes. 

8.7 Choose a Screensaver 

To change your screensaver: 

1. Right click the desktop and click Personalize. 
2. Click Screen Saver. 

 
3. Choose a screensaver from the list (download 

screensavers.) 

http://mintywhite.com/tech/category/screensavers/�
http://mintywhite.com/tech/category/screensavers/�
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4. Click Settings and specify the options you want for 
the screen saver. 

From this screen, you can also: 
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• Preview the screen saver in full-screen view. 
• Specify the length of time you want your computer 

to be inactive before the screen saver starts. 
• Optionally require log on after you stop the 

screensaver running. 

8.8 Recommended Screensavers 

There are so many screensavers available and many are 
either resource intensive or packed with malware (or both.) 
Here is a list of some of the best screensavers that are low 
on resource consumption. 

8.8.1 Photo/Video Slideshow Screensaver 

To use your photos and videos as a slide show: 

1. Right click the desktop and click Personalize. 
2. Click Screen Saver. 
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3. Select Photos in the Screen Saver list. 

 

4. Click Settings. 
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5. a. Choose pictures from your photo folders (limit 
by tags or ratings.) 
b. OR choose pictures from a specific folder (click 
Browse to specify the folder.) 

6. Specify a theme for the display. 
7. Specify the speed at which you want the pictures to 

change. 
8. Specify whether or not you want your pictures 

appear in random order. 
9. Click Save and click OK. 
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8.8.2 Other Recommended Screensavers 

I have a collection of screensavers here that you can 
download and use. 

 

http://mintywhite.com/tech/category/screensavers/�


 

 

9 Customize Windows Explorer 

Windows Explorer is your main portal to all your files. You 
can greatly increase your efficiency by making some 
simple changes. You can also add a personal touch to your 
file structure. 

In this chapter, you’ll learn how to standardize the view of 
Windows Explorer, set up quickly accessible shortcuts, 
improve the way you select files, and customize your 
folder icons. 

9.1 Set Views for all Folders 

Windows 7 does a pretty good job at analyzing the content 
of a folder to determine how it should display the files. 
98% of the time I want to see the details of the files and I 
don’t care for thumbnails, tags, ratings, etc. If you are like 
me and want to simplify Windows Explorer’s view: 
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1. Open and folder and customize it in a way that you 
want reflected across all your folders. 

2. Press the Alt key once and then click Tools > 
Folder Options. 

 
3. Click the View tab and click Apply to Folders. 
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4. When prompted, click Yes and your settings will 

now be in effect. 

Please Note: Any previous customization might be retained 
for specific folders you’ve already worked with—but don’t 
count on it. 
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9.2 Set up Shortcuts to Common 
Folders 

Explorer has a great feature in Windows 7: the shortcut 
menu, which is, by default, shown in the left-hand. This 
shortcut menu is customizable and can save you a lot of 
time if you frequently open and close files from specific 
locations. 

9.2.1 Adding Shortcuts to the Shortcut Menu 

To add a shortcut to the menu: 

1. Locate the folder you want to add. 
2. Click on it and drag it to the menu. 
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9.2.2 Remove Shortcuts from the Shortcut 
Menu 

To remove a shortcut from the menu: 

1. Right click on the shortcut. 
2. Click Delete. 
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9.3 Select Multiple Files with 
Checkboxes 

When you want to select multiple files, you need to hold 
the Ctrl key, while clicking on each file name; if you let go 
of the key before selecting another file, you lose your 
entire selection. Windows 7’s solution to this is to allow 
you to select check boxes next to files, so you do not have 
to hold the Ctrl key. 

To enable check box file selection: 

1. Within the folder, press the Alt key once and then 
click Tools > Folder Options. 
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2. Click the View tab and under Advanced settings, 
locate and click Use check boxes to select items. 

 

Now you can check the files you want to collectively select. 
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9.4 Customize Folder Icons 

I use some folders as a dashboard to get to commonly 
used folders. A good example of this is my ‘Media’ 
partition. Here, I have my Music, Video, Pictures, and other 
folders. In this section, you’ll learn how to customize your 
folder icons to achieve something similar to Figure 29. 

 

Figure 29: Customized Folder Icons 

To change your folder icons: 
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1. Right click on the folder you want to customize the 
icon for and click Properties. 

 
2. Click the Customize tab and click on Change Icon… 
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3. Click an Icon or browse for your own (get 

thousands of icons here.) 

http://mintywhite.com/tech/category/icons/�
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4. Click OK on both screens and you are done 

Note: To view larger icons in Windows Explorer, click the 
Views button, on the toolbar, until you get to large icons. 
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9.5 Set AutoPlay Defaults 

Although I do not find Autoplay to be a useful feature, 
many do. In this section, you’ll learn how to set Autoplay 
defaults in Windows 7. 

The defaults will save you time as you use media with your 
PC. For example: you can set DVDs to play or rip CDs 
automatically. 

To set Autoplay defaults in Windows7: 

1. Click the Start button, type auto, and click on 
Autoplay. 

2. When the Autoplay screen comes up, click which 
programs or actions you would like to take for each 
media type. 
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3. When you are finished, click Save. 

Note: You can change your settings later if you change 
your mind. 

 



 

 

10 Work Efficiently 

There are many things we do on a day-to-day basis that 
become very repetitive. When we find a way to do these 
things more quickly, we save a lot of time. This chapter 
mainly consists of shortcut keys combinations, which 
perform a task with minimal effort. There is a reason for 
this: shortcut keys save you a lot of time!  

I tried to count the number of times I used a shortcut key 
while writing this chapter. I’m sure I missed a lot because I 
automatically use them; however, I counted over one 
hundred times; that’s a lot. I saved a lot of time while 
putting this chapter together.  

10.1 Windows 7 Shortcut Keys 

Combination Result 
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+ Dock window to the left-hand 
side of the screen 

+ Dock window to the right-hand 
side of the screen 

+Shift+ Move the current selected 
window one monitor to the left 

+Shift+ Move the current selected 
window one monitor to the right 

+Shift+ Expand non-maximized window 
to the left (or any arrow key 
direction) 

+Ctrl+ Contract non-maximized 
window from the left (or any 
arrow key direction) 

+ Maximize current window 

+↓ Minimize current window 

+ +, + - Zoom in and out 

+Home Minimize/maximize non-active 
windows 
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+1, 2, 3, 4, or 5 Launch programs from the 
taskbar 

+Space Enable Aero Peek 

+G Bring gadgets to the foreground 

+P Open "projector" mode to 
change external display settings 

+T Jump to the taskbar to select a 
new window with  or  + 
Enter 

+X Open Windows mobility center 

Ctrl+Left Click Use on taskbar items to switch 
between windows of that 
program only 

 

10.2 General Windows Shortcut Keys 

There are so many shortcut keys in Windows—here are the 
best of them: 
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10.2.1 Single Keys 

Combination Result 

F2 Rename the selected item 

F3 Search for a file or folder 

F4 Display the address bar list in 
Windows Explorer 

F5 Refresh the active window 

F6 Cycle through screen elements in 
a window or on the desktop 

F10 Activate the menu bar on the 
active program 

Delete Delete the selected item (and 
move it to the recycle bin) 

Esc Cancel the current task (close 
select windows) 

Right Arrow Open the next menu to the right 
or open a submenu 
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Left Arrow Open the next menu to the left 
or open a submenu 

 

10.2.2 Ctrl-Key Shortcuts 

Combination Result 

Ctrl+A Select all the items in a 
document or window 

Ctrl+C Copy the selected item to the 
clipboard 

Ctrl+X Cut the selected item  

Ctrl+V Paste the current item in the 
clipboard 

Ctrl+Z Undo an action 

Ctrl+Right Arrow Move the cursor to the beginning 
of the next word 

Ctrl+Down Arrow Move the cursor to the beginning 
of the next paragraph 
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Ctrl+Left Arrow Move the cursor to the beginning 
of the current word 

Ctrl+Up Arrow Move the cursor to the beginning 
of the current paragraph 

Ctrl+Shift+Arrow Key Select a block of text 

Ctrl+F4 Close the active document (in 
programs that allow you to have 
multiple documents open 
simultaneously 

Ctrl+F5 Refresh the current page in 
browsers (including refreshing 
cached files) 

Ctrl+Esc Open the Start menu 

Ctrl+Shift+Esc Open Task Manager 

Ctrl+Alt+Tab Switch between windows using 
the arrow keys 

 

10.2.3 Shift Key Shortcuts 

Combination Result 
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Shift+Delete Delete the selected item without 
removing it to the recycle bin 

Shift when inserting 
CD/DVD/Bluray 

Prevent the media from 
automatically playing 

Shift+Arrow Key Select more than one item within 
a window or on the desktop, or 
select blocks of text within a 
document 

Shift+F10 Display the shortcut (right click) 
menu for the selected item 

 

10.2.4 Alt Key Shortcuts 

Combination Result 

Alt+Enter Display properties of the 
selected item 

Alt+F4 Close the active item or exit the 
active program 

Alt+Space Open the shortcut menu for the 
active window 
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Alt+Tab Switch between open items 

Alt+Esc Cycle through items in the order 
in which they were opened 

Alt+Underlined letter Display the corresponding menu 
or perform the menu/button 
command 

Alt+Up Arrow View on folder up in Windows 
Explorer 

 

10.3 Windows Photo Gallery Shortcut 
Keys 

Use these shortcut keys when using Windows Photo 
Gallery.  

10.3.1 General Shortcut Keys 

Combination Result 

Ctrl+B Best fit 
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Ctrl+E Search for an item 

Ctrl+F Open the fix pane 

Ctrl+I Open or close the details pane 

Ctrl+P Print the selected picture 

Ctrl+. Rotate the picture clockwise 

Ctrl+, Rotate the picture counter/anti-
clockwise 

Alt+ Go back 

Alt+Right Arrow Go forward 

F2 Rename the selected item 

Enter View the selected picture at a 
larger size 

+ Zoom in 

- Zoom out 

Right Arrow Expand Node 



271 10 Work Efficiently 
 

 

Down Arrow Select the next item or row 

 Collapse Node 

Up Arrow Select the previous item or row 

Page Up Previous Screen 

Page Down Next Screen 

Home  Select the first item 

End Select the last item 

Delete Move the selected item to the 
recycle bin 

Shift+Delete Permanently delete the selected 
item 

 

10.3.2 Shortcut Keys When Working with 
Videos 

Here are some Windows Photo Gallery shortcut keys you 
can use when working with videos: 
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Combination Result 

I Set the start trim point 

J Move back one frame 

K Pause playback 

L Move forward one frame 

M Split a clip 

O Set the end trim point 

Ctrl+K Stop and rewind playback 

Ctrl+P Play from the current location 

Alt+Right Arrow Advanced to the next frame 

Alt+Left Arrow Go back to the previous frame 

Home Move to the start trim point 

End Move to the end trim point 

Page Up Seek to nearest split point before 
the current location 
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Page Down Seek to nearest split point after 
the current location 

 

10.4 Microsoft Word Shortcut Keys 

Some of these shortcuts may not work in older versions of 
Word; however, they are tested and working in Word 2007. 

Combination Result 

Ctrl + A Select all contents of the page. 

Ctrl + B Bold highlighted selection. 

Ctrl + C Copy selected text. 

Ctrl + D Open the font dialogue box. 

Ctrl + E Aligns the line or selected text to 
the center of the screen. 

Ctrl + F Open find box. 

Ctrl + G Open find and replace box. 
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Ctrl + H Also opens find and replace box. 

Ctrl + I Italicize highlighted selection. 

Ctrl + J Justify (spread) the text across 
the page. 

Ctrl + K Insert link. 

Ctrl + L Aligns the line or selected text to 
the left of the screen. 

Ctrl + M Indent the paragraph. 

Ctrl + N Open a new document. 

Ctrl + O Open a document stored on your 
hard drive. 

Ctrl + P Open the print window. 

Ctrl + R Aligns the line or selected text to 
the right of the screen. 

Ctrl + S Saves the current document. 

Ctrl + U Underline highlighted selection. 
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Ctrl + V Paste contents of clipboard. 

Ctrl + W Closes the current document. 

Ctrl + X Cut selected text. 

Ctrl + Y Redo the last action performed. 

Ctrl + Z Undo last action. 

Ctrl + Shift + F Change the font. 

Ctrl + Shift + > 
Increase selected font +1pts up 
to 12pt and then increases font 
+2pts. 

Ctrl + ] Increase selected font +1pts. 

Ctrl + Shift + < 
Decrease selected font -1pts if 
12pt or lower, if above 12 
decreases font by +2pt. 

Ctrl + [ Decrease selected font -1pts. 

Ctrl + Shift + * View or hide non printing 
characters. 

Ctrl + <left arrow> Moves one word to the left. 
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Ctrl + <right arrow> Moves one word to the right. 

Ctrl + <up arrow> Moves to the beginning of the 
line or paragraph. 

Ctrl + <down arrow> Moves to the end of the 
paragraph. 

Ctrl + Del Deletes word to right of cursor. 

Ctrl + Backspace Deletes word to left of cursor. 

Ctrl + End Moves the cursor to the end of 
the document. 

Ctrl + Home Moves the cursor to the 
beginning of the document. 

Ctrl + Spacebar Reset highlighted text to the 
default font. 

Ctrl + 1 Single-space lines. 

Ctrl + 2 Double-space lines. 

Ctrl + 5 1.5-line spacing. 

Ctrl + Alt + 1 Changes text to heading 1. 
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Ctrl + Alt + 2 Changes text to heading 2. 

Ctrl + Alt + 3 Changes text to heading 3. 

Ctrl + F1 Open the Task Pane. 

F1 Open Help. 

Alt + Ctrl + F2 Open new document. 

Ctrl + F2 Display the print preview. 

Shift + F3 
Change the text from upper to 
lower case or a capital letter at 
the beginning of every word. 

Shift + Insert Paste. 

F4 Repeat the last action 
performed. 

F5 Open the find, replace, and go to 
window in Microsoft Word. 

Ctrl + Shift + F6 Opens to another open Microsoft 
Word document. 

F7 Spell and grammar check 
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selected text and/or document. 

Shift + F7 Runs a Thesaurus check on the 
word highlighted. 

F12 Save as. 

Shift + F12 Save. 

Ctrl + Shift + F12 Prints the document. 

Alt + Shift + D Insert the current date. 

Alt + Shift + T Insert the current time. 
 

10.5 Remote Desktop Shortcut Keys 

Use these shortcut key combinations, as replacements to 
their equivalent, in remote desktop. 

Combination Effect Equivalent 

Ctrl+Alt+End Interrupt keys Ctrl+Alt+Del 
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Alt+Home Displays the Windows 
start menu 

 

Alt+Page Up Switch between 
programs to the left 

Alt+Tab+Left 
Arrow 

Alt+Page Down Switch between 
programs to the right 

Alt+Tab+Right 
Arrow 

Alt+Insert Switch between 
programs in most 
recently used order 

Alt+Tab 

Alt+Del Window (context) 
menu 

Alt+Space 

Ctrl+Alt+Break Changes remote 
window to full screen 
and back 

Alt, Space, X 

Ctrl+Alt+Left 
Arrow 

Switches you to host 
computer 

- 

Ctrl+Alt+Right 
Arrow 

Switches you back to 
remote computer 

- 

Ctrl+Alt+Plus(+) Screen shot of the 
whole screen 

Prnt Scrn 
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Ctrl+Alt+Minus 
(-) 

Screen shot of the 
active window 

ALT+Prnt Scrn 

 

 

10.6 Useful Windows Commands 

By using Windows commands, you can have quick access 
to tools to configure and fix your computer. They also 
allow you quick access to Microsoft software embedded 
within your operating system. Some of these commands 
can be very useful. Some are not so useful but can be fun 
to try. 

Open the Run dialogue, by pressing +R 

Now type in one of the following commands to open a 
program. (Note: Some of these programs may not be 
available in your Windows 7 editions.) 

10.6.1 Windows Environment Controls 

Command Result 
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%ALLUSERSPROFILE% Open the All User's Profile  

%HomeDrive% Opens your home drive e.g. C:\ 

%UserProfile% Opens your User's Profile  

%temp% 
  

Opens the temporary file Folder  

%systemroot% Opens Windows folder  
 

10.6.2 Consoles, Programs etc. 

Command Result 

access.cpl Accessibility Controls 

hdwwiz.cpl Add Hardware Wizard 

appwiz.cpl Add/Remove Programs 

control admintools Administrative Tools 

wuaucpl.cpl Automatic Updates 
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fsquirt Bluetooth Transfer Wizard 

calc Calculator 

certmgr.msc Certificate Manager 

charmap Character Map 

chkdsk Check Disk Utility 

clipbrd Clipboard Viewer 

cmd Command Prompt 

dcomcnfg Component Services 

compmgmt.msc Computer Management 

control panel Control Panel 

timedate.cpl Date and Time Properties 

ddeshare DDE Share 

devmgmt.msc Device Manager 

directx.cpl Direct X Control Panel 
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dxdiag Direct X Troubleshooter 

cleanmgr Disk Cleanup Utility 

dfrg.msc Disk Defragment 

diskmgmt.msc Disk Management 

diskpart Disk Partition Manager 

control desktop Display Properties 

desk.cpl Display Properties 

control color Display Properties 

drwtsn32 Dr. Watson System 
Troubleshooting Utility 

verifier Driver Verifier Utility 

eventvwr.msc Event Viewer 

sigverif File Signature Verification Tool 

findfast.cpl Findfast 

control folders Folders Properties 



Windows 7 – The Pocket Guide 284 
 

 

control fonts Fonts 

fonts Fonts Folder 

freecell Free Cell Card Game 

joy.cpl Game Controllers 

gpedit.msc Group Policy Editor (XP Prof) 

mshearts Hearts Card Game 

iexpress Iexpress Wizard 

ciadv.msc Indexing Service 

inetcpl.cpl Internet Properties 

Iexplore Internet Explorer 

ipconfig /all IP Configuration (Connection 
Configuration) 

ipconfig /displaydns IP Config (DNS Cache Contents) 

ipconfig /flushdns IP Config (Delete DNS Cache 
Contents) 
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ipconfig /release IP Config (Release All 
Connections) 

ipconfig /renew IP Config (Renew All Connections) 

ipconfig /registerdns IP Config (Refresh DHCP & Re-
Registers DNS) 

ipconfig 
/showclassid 

IP Config (Display DHCP Class ID) 

ipconfig /setclassid IP Config (Modifies DHCP Class 
ID) 

jpicpl32.cpl Java Control Panel (If Installed) 

javaws Java Control Panel (If Installed) 

toy.cpl Joystick Properties 

control keyboard Keyboard Properties 

main.cpl keyboard Keyboard Properties 

secpol.msc Local Security Settings 

lusrmgr.msc Local Users and Groups 
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logoff Logs You Out Of Windows 

winchat Microsoft Chat 

winmine Minesweeper Game 

control mouse Mouse Properties 

main.cpl Mouse Properties 

control 
netconnections 

Network Connections 

ncpa.cpl Network Connections 

netsetup.cpl Network Setup Wizard 

notepad Notepad 

nvtuicpl.cpl Nview Desktop Manager (If 
Installed) 

packager Object Packager 

odbccp32.cpl ODBC Data Source Administrator 

osk On Screen Keyboard 
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ac3filter.cpl Opens AC3 Filter (If Installed) 

password.cpl Password Properties 

perfmon.msc Performance Monitor 

perfmon Performance Monitor 

telephon.cpl Phone and Modem Options 

powercfg.cpl Power Management 

control printers Printers and Faxes 

printers Printers Folder 

eudcedit Private Character Editor 

QuickTime.cpl Quicktime (If Installed) 

intl.cpl Regional Settings 

regedit Registry Editor 

regedit32 Registry Editor 

mstsc Remote Desktop 
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ntmsmgr.msc Removable Storage 

ntmsoprq.msc Removable Storage Operator 
Requests 

rsop.msc Resultant Set of Policy (XP Prof) 

sticpl.cpl Scanners and Cameras 

control schedtasks Scheduled Tasks 

wscui.cpl Security Center 

services.msc Services 

fsmgmt.msc Shared Folders 

shutdown Shuts Down Windows 

mmsys.cpl Sounds and Audio 

spider Spider Solitare Card Game 

cliconfg SQL Client Configuration 

sysedit System Configuration Editor 

msconfig System Configuration Utility 
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sfc /scannow System File Checker (Scan 
Immediately) 

sfc /scanonce System FC (Scan Once At Next 
Boot) 

sfc /scanboot System FC (Scan On Every Boot) 

sfc /revert System FC (Return to Default 
Setting) 

sfc /purgecache System FC (Purge File Cache) 

sfc /cachesize=x System FC (Set Cache Size to size 
x) 

sysdm.cpl System Properties 

Taskmgr Task Manager 

nusrmgr.cpl User Account Management 

utilman Utility Manager 

explorer Windows Explorer 

firewall.cpl Windows Firewall 
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magnify Windows Magnifier 

wmimgmt.msc Windows Management 
Infrastructure 

syskey Windows System Security Tool 

wupdmgr Windows Update Launches 

winver Windows Version 

tourstart Windows XP Tour Wizard 

Write WordPad 
 

10.7 Windows Shell Folder Commands 

Open the run dialogue by pressing +R 

Now type in one of the following commands to open a 
folder. (Note: Some of these programs/folders may not be 
available in your edition of Windows 7.) 
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10.7.1 Personal Folders 

Command Result 

shell:Personal Shows the user Documents 
folder 

shell:My Music Opens your Music folder 

shell:CommonMusic Opens the public Music Folder 

shell:Playlists Shows the user \Music\Playlists 
folder 

shell:SamplePlaylists Opens the playlists folder 

shell:My Video Opens your Video folder 

shell:CommonVideo Opens the public Video Folder 

shell:My Pictures Opens your Pictures folder 

shell:CommonPictures Opens the public Pictures Folder 

shell:Original Images Opens the original images edited 
By Windows Photo Gallery 

shell:SamplePictures Opens the sample pictures folder 
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shell:PhotoAlbums Opens the slideshows folder 
 

10.7.2 User Folders 

Command Result 

shell:AppData Shows the user Application 
Data folder 

shell:CD Burning Shows the folder where files 
are stored before being burned 
to disc 

shell:Contacts Shows the user Windows 
Contacts folder 

shell:CredentialManager Shows the user Credentials 
folder 

shell:Cryptokeys Shows the user encryption keys 
folder 

shell:Desktop Shows the user desktop folder 

shell:Downloads Shows the user downloads 
folder 
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shell:Gadgets Shows the user folder of 
downloaded Sidebar Gadgets 

shell:GameTasks Shows the user Game Explorer 
folder 

shell:History Shows the user History folder 

shell:Links Shows the user Links folder 

shell:Local AppData Shows the user Application 
Data folder 

shell:Local AppDataLow Shows the user Application 
Data (Low Integrity) folder 

shell:NetHood Shows the user Network Places 
folder 

shell:PrintHood Shows the user printer 
shortcuts folder 

shell:Profile Shows the user profile folder 

shell:Programs Shows the user Start Menu 
Programs folder 

shell:Quick Launch Shows the Quick Launch folder 
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shell:Recent Shows the user’s Recent 
Documents folder 

shell:SavedGames Shows the Saved Games folder 

shell:Searches Shows the saved searches 
folder 

shell:SendTo Shows the user Send To folder 

shell:Start Menu Shows the user Start Menu 
folder 

shell:Startup Shows the user Startup folder 

shell:SystemCertificates Shows the user certificates 
folder 

shell:Templates Shows the user Templates 
folder 

 

10.7.3 System Folders 

Command Result 

shell:AppUpdatesFolder Shows installed Windows 
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Updates 

shell:Common AppData Shows the Public 
Application Data folder 

shell:Common Desktop Shows the Public Desktop 

shell:Common Documents Shows the Public 
Documents folder 

shell:CommonDownloads Shows the Public Downloads 
folder 

shell:Common Programs Shows the Public Start Menu 
Programs folder 

shell:Common Start Menu Shows the Public Start Menu 
folder 

shell:Common Startup Shows the Public Startup 
folder 

shell:Common Templates Shows the Public Templates 
folder 

shell:Default Gadgets Shows the default Sidebar 
Gadgets folder 

shell:Fonts Shows the Fonts folder 
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shell:Games Shows the Games folder 

shell:MyComputerFolder Shows the Computer folder 

shell:OEM Links Shows links provided by 
your PC manufacturer 

shell:NetworkPlacesFolder Shows the Network Places 
folder 

shell:PrintersFolder Shows the Printers folder 

shell:ProgramFiles Shows the Program Files 
folder 

shell:ProgramFilesCommon Shows the Program 
Files\Common Files folder 

shell:Public Shows the Public folder 

shell:PublicGameTasks Shows the Public Game 
Explorer folder 

shell:ResourceDir Shows the Windows 
Resources folder 

shell:RecycleBinFolder Shows the Recycle Bin 
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shell:System Shows the Windows System 
folder 

shell:UserProfiles Shows the folder holding all 
user profiles 

shell:Windows Shows the Windows 
installation folder 

 

10.7.4 Applications 

Command Result 

shell:Administrative Tools Shortcuts to 
applets in 
Administrative 
Tools folder 

shell:Common Administrative Tools Shortcuts to Public 
applets in 
Administrative 
Tools 

shell:AddNewProgramsFolder Control Panel's 
Install a program 
from the network 
applet 
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shell:ChangeRemoveProgramsFolder Control Panel's 
Uninstall or change 
a program applet 

shell:ConnectionsFolder Shows the list of 
Network 
Connections 

shell:ControlPanelFolder Shows Control 
Panel 

shell:SearchHomeFolder Shows the 
Windows Search 
tool 

 

10.7.5 Internet Explorer 

Command Result 

shell:InternetFolder Opens IE  

shell:Favorites Opens IE favorites 

shell:Cache Opens IE cache 

shell:Cookies Opens IE cookies 
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10.8 Sync System Clock with Internet 
Time 

Just as in Vista, you can synchronize your clock with an 
internet-based server. This will ensure that your computer 
date and time is always correct. Having the correct time is 
essential, especially when you want to search for files 
modified on a specified date; if the date is incorrect, you 
will have trouble finding your files. 

In this section, you’ll learn how to sync your clock’s time 
with time.windows.com’s time. 

To synchronize your clock: 

1. Click the Clock and click Change time and date 
settings… 

2. Under the Internet Time tab, click Change Settings. 
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3. Check Synchronize time with an Internet time 
server. 
I chose to use the default windows.time.com and 
chose Update now. Then click OK. 
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Now your PC will maintain the correct time and 
resynchronize frequently (requires an internet connection.) 

 



 

 

11 Organize Your Files 

There are many ways to organize your files; an in-depth 
organization solution is beyond the scope of this book. 
However, this chapter offers a few tips to help you keep on 
top of your files. 

In this chapter, you’ll learn how to automatically move files 
from your desktop, use naming conventions, batch rename 
your files, and relocate your personal document folders 
from the default locations set in Windows 7. 

11.1 Automatically Move Files from 
Your Desktop 

Do you have a cluttered desktop? Do you spend time 
looking for the documents and pictures you’ve saved 
recently and then move them to different folders? If this is 
the case, or if you just like a clean desktop, this section is 
for you. Desktop teleporter is a great utility that moves 
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files and folders that are newly created on your desktop to 
pre-determined folders. 

To automate the process of organizing your desktop: 

1. Download Desktop Teleporter. 
2. Set up rules to help manage images, music, 

documents etc. 
3. Set exceptions to your rules if you need them. 

[Click to see an image of my clutter-free desktop] 

11.2 Use Naming Conventions to 
Organize Your Data 

Here you can see the naming conventions I use for my 
files. This is just a guide to get you started on your own 
system. I set many of these conventions many years ago, 
but they work. Experience has given me newer ideas, some 
of which I am currently using. 

http://tchikien.donationcoders.com/�
http://mintywhite.com/images/forum/090826desktop.png�
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Photo Files 

I archive my photos in the following way (Refer to Figure 
30):  

Photo > %Year% > %Date% Title 

Figure 30: Photo Folder Organization 

Documents 

Even though you can sort files by date in all popular OSs, I 
still prepend a date to the front of a file. This helps me 
with versioning. Also, I usually remember when I wrote 
something, and not what I called it. Figure 31 shows how I 
organize documents. 
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Figure 31: Document Organization 

Music 

Everyone names their music differently; this is my way. I’m 
not an MP3 tag person, so I would probably use this for 
inspiration and not instruction. 

I name my music files: 

Music > %genre% > %album_title% 

All individual songs that I buy separately go into a genre 
folder, along with any albums that are in their own folders. 
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Tags essentially do the same thing, but when you have 
over 100 albums (or 1000s as can be the case) it helps to 
do some organization within your file structure (see Figure 
32.) 

Figure 32: Music Organization 

Please visit this page, for screenshots of my file system. 

11.3 Batch Rename Your Files 

I don’t remember when I first started using D-File Mu, but 
it is an invaluable tool for me. I use it all the time and I 
recommend it to anyone. It can take a little getting used 
to, but it’s not too complicated and works very well. 

http://mintywhite.com/tech/xp/use-naming-conventions-to-organize-your-data/�
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Download D-FileMU 

11.3.1 D-FileMU Features 

D-File MU performs the following changes: 

• Adding strings to the beginning and end of the 
filenames. 

• Deleting specified number of characters from 
beginning or end of the filenames. 

• Adding numbers in sequence to the beginning or 
end of the filenames. 

• Changing to upper or lowercase. 
• Replacing strings with specified string. 
• Changing the file extension of filenames. 
• Capitalizing words and more. 

11.4 Relocate Personal Data Folders 

I don't like having my personal files on the system drive. If 
you get a virus or reinstall your operating system, you 
stand a higher chance of losing your files. I always keep 
my personal files on a separate partition or drive. Windows 

http://www.softpedia.com/get/System/File-Management/D-FileMU.shtml�
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likes to store your saved videos, music, pictures, etc, in 
your Personal folder. In this section, you'll learn how to 
relocate your personal folders and files. 

To relocate your personal folders and files: 

1. Open Windows Explorer and navigate to your 
personal folders (Usually C:\Users\[your account 
name]\.) 

 
2. Right click a personal folder that you want to 

relocate and click Properties. 
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3. On the Location tab of the properties dialog box, 

enter the address to which you want to relocate the 
folder. 
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4. Click OK. 
5. Windows will ask permission to create the target 

folder if it doesn’t already exist, so click Yes. I 
advise moving all the original files to the new 
location, unless you see a reason not to. 

6. Now you may add your new files to the search 
index. An explanation of how to do this is found 
later in this chapter. 
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11.5 Organize the Search Index 

The search index is a powerful tool that helps you locate 
your files very quickly. However, the search indexing 
service can be very resource intensive (usually when you’re 
not using your PC) and also takes up hard drive space. I 
customize the search index to suit my needs.  

To customize the search index: 

1. Click Start, type search, and click Change how 
Windows searches. 

2. You will now see which files are indexed. Because I 
don’t store personal files on the C partition 
(Relocate Personal Data Folders), I’ve removed it 
completely from the search index. 
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3. Click Modify to change which locations are 
indexed. 
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4. Press OK and then Close to save your preferences. 
Windows will now get to work as it adds and 
removes data from the search index. 

11.6 Index Zip File Contents for 
Searching 

As hard drive capacities increase, the search function is a 
necessity when trying to access your files. To include zip 
file contents when searching in Windows 7: 

1. Click the Start button and click on Computer. 
2. Press the Alt key and click Tools > Folder Options. 
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3. Under the Search tab, check Include compressed 
files, and click OK. 
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Now, when you search, you’ll be able to find data in 
compressed files. 

11.7 Scan Your Drive for Duplicate Files 

Do you have thousands of photos, documents, songs, etc, 
on your hard drive? If you do, you’ll likely have duplicates 
all over the place. In this section, you’ll learn how to 
search for duplicates and delete them. 

Download Easy Duplicate Finder 

11.7.1 Easy Duplicate Finder Features 

• Search for true duplicates (files with same 
contents.) 

• Powerful search engine with fast files check. 
• Full binary (byte-by-byte) comparison. 
• Flexible Scan settings. 

• Search files by “masks”. 
• Size criteria & skip zero-length files option. 
• Find duplicates from selected folders or drives. 
• Select multiple folders/drives for scanning. 

http://www.easyduplicatefinder.com/download.html�
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• Protect system files and folders. 
• Move files to Recycle Bin or delete duplicate files 

permanently. 
• Mark selected duplicates by renaming them with 

adding prefix to file names—to test what files are 
safe to delete. 

• Much more. 



 

 

Glossary 

Coming soon… 

 



 

 

Appendices



 

 

Appendix A: Version History 

Version Date Revisions 
0.1 14 Feb ‘09 First edition prepared 

0.1.1 28 Feb ‘09 Grammatical changes 

0.1.2 24 March 
‘09 

Finalized “RC1” Edition for preview 
by readers 

0.1.3 25 March 
‘09 

Fixed some consistency issues 

0.1.4 30 June 
‘09 

Updated for Windows 7 RC 
Consistency 

0.2 17 July ‘09 Major rework of book: New guides, 
formatting, grammatical changes, 
style changes etc. 

0.2.1 24 August 
‘09 

• Updated book for consistency 
with Windows 7 RTM 

• Added more guides 
• Added appendicies 
• New cover page 

0.2.2 30 August 
‘09 

• Grammar update 
• Preparation for translation 

Get the latest version of the book here 
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Appendix B: Contact Me 

You may have questions as you read this book—please 
don’t keep them to yourself—ask me them anytime. There 
are a number of ways you can contact me: 

 Website: http://mintywhite.com  

 Email: rich@mintywhite.com  

 Twitter: http://twitter.com/mintywhite  

 Digg: http://digg.com/users/mintywhite  

 Plurk: http://www.plurk.com/user/mintywhite  

 StumbleUpon: http://mintywhite.stumbleupon.com  

AIM: mintywhitecom 

 MSN: mintywhitecom@hotmail.com  

 Yahoo: mintywhitecom 

http://mintywhite.com/�
mailto:rich@mintywhite.com�
http://twitter.com/mintywhite�
http://digg.com/users/mintywhite�
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Appendix C: Create a System Restore 
Point 

A system restore point is a snapshot of your PC and it’s 
settings. This is useful if anything goes wrong and you 
want to roll back your system to a previous, working state. 

As you work through this book, you may be required to 
make significant system changes. In these cases, create a 
restore point before you make changes. 

Create a System Restore Point 

To create a system restore point: 

1. Click Start, type protection, and click Create a 
restore point. 

2. On the System Properties dialogue, click Create. 
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3. Give your restore point a name. 
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4. Wait as your system restore point is created. 

 

5. Your restore point is ready to use when you need it. 
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Restore to a Previous Restore Point 

To restore to a previous point: 

1. Click Start, type restore, and click System Restore. 
2. If you followed the previous part of this section, 

you’ll already have a restore point to work with. 
Some programs (Advanced SystemCare and 
Windows Update) create restore points too, so you 
should have a few by now. Click Next. 
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3. Select your restore point and Next. 
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4. Click Finish. 
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5. System restore make take some time (up to an 
hour), so enjoy the break from your PC. 

 



 

 

Appendix D: Launch Windows Registry 
Editor 

To access the Windows Registry: 

1. Click the Start button, type regedit, and press 
Enter  

 
2. When prompted, click Yes 
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Appendix E: Back up the Windows 
Registry 

To back up the Windows registry: 

1. Click the Start button and type regedit. 
2. Left click Computer in the left pane. 

 
3. Go to File > Export. 

 
4. Save the file (for extra precaution, save the file to a 

USB thumb drive.) 
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Appendix F: Burn Data to 
CD/DVD/Bluray 

To burn files to you disc: 

1. Put a blank or rewriteable disc in your optical 
media drive. 

2. When Autoplay loads, click Burn files to disc. 
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3. Give your disc a title and choose which type of disc 
you’d like to create. I chose to write only once to 
the disc, but you can write multiple times (and 
rewrite if you are using a rewritable disc.) 

 

4. Drag and drop files to the burn folder. 
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5. Your files are now ready to be burned to your disc. 

 

6. When you’ve copied all your files, click Burn to disc. 
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7. Verify your disc name and click Next. 
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8. Your data will now be copied to your disc. 
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9. Verify your disc works by accessing it through 
Computer (+E) or using it in another computer. 

 

 



 

 

Appendix G: Burn an ISO Image to a 
Disc 

Windows 7 burns ISO images natively; however, Windows 
XP and Vista do not. Learn, in this section, how to burn 
and ISO to a disc in Windows XP or Vista and how to do 
this in Windows 7. 

Burn an ISO to Disc in Windows XP or Vista 

 To burn an ISO image to a disc in Windows XP or Vista: 

1. Download ImgBurn. 
2. Install ImgBurn on your PC. 

http://www.imgburn.com/index.php?act=download�
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3. Open ImgBurn and click Write image file to a disc. 
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4. Click the Browse for file icon. 

 

5. Locate the ISO image and click Open. 
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6. Click Write. 

 

7. ImgBurn will now create your DVD (I strongly 
recommend verifying the disc with ImgBurn by 
checking Verify.) 
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8. If you get the following error and are using a 
laptop, don’t worry: this is normal. 
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9. ImgBurn will notify you when the disc is 
successfully burned and verified. 

 

10. Verify your disc works by opening in Computer or 
checking it on another PC. i.e., if you are burning 
the Windows 7 DVD: go to Computer (+E), 
double click on your optical drive’s icon, and 
double click on setup.exe. The Windows 7 install 
tool should load. 
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Burn an ISO to Disc in Windows 7 

To burn an ISO image to a disc in Windows 7: 

1. Put a blank or rewriteable disc in your disc drive. 
2. Locate your ISO file, right click in and click Burn 

disc image. Note: if another program has assumed 
responsibility for ISO files, you’ll need to change 
the default program (Appendix J: Change the 
Default Program to Handle a File Type .) 
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3. I encourage you to verify the disc. Click Burn. 
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4. Verify your disc works by opening in Computer or 
checking it on another PC. i.e., if you are burning 
the Windows 7 DVD: go to Computer (+E), 
double click on your optical drive’s icon, and 
double click on setup.exe. The Windows 7 install 
tool should load. 

 



 

 

Appendix H: Boot from a CD or DVD 

When you first boot your PC, you are not in Windows yet; 
you are booting from BIOS, which means there are no 
standards and each computer differs. 

Due to the number of computer brands and BIOS versions, 
a comprehensive guide is not provided here. However, I do 
provide some quick tips: 

• Have the disc in the drive as the computer is turned 
on. 

• Wait and you may be prompted to press any key to 
boot from the disc. 

• Look out for something like F12 Boot Menu when 
your computer is starting. 

• When the boot menu loads, select optical disc drive 
(or equivalent) and hit enter. 

• Ask the experts. 

 

http://mintywhite.com/forum/�


 

 

Appendix I: Create a Partition with 
GParted 

Note: If you are using Windows Vista or 7, you should use 
the built in disk management tool (Create a New Partition 
using Vista.) Windows XP disc management tool is not 
adequate and you should use something free like GParted. 

To create a partition with GParted: 

1. Download the GParted live CD here. 
2. Burn the image to a CD (Appendix G: Burn an ISO 

Image to a Disc), reboot your computer, and boot 
from the CD (Appendix H: Boot from a CD or DVD.) 

3. Press Enter at the boot prompt; choose your 
language, keymap, and screen resolution. 

http://gparted.sourceforge.net/download.php�
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4. You will now see your disks and partitions. 
5. Select the partition you want to resize and click 

Resize/Move. 

 
6. Drag the partition to the desired size and click 

Resize/Move. 
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7. Now exit GParted and either boot back into 
Windows or boot from your operating system 
installation disc. 

 



 

 

Appendix J: Change the Default 
Program to Handle a File Type 

If you want to open a file type in another program, do the 
following: 

1. Right click on the file and click Open with > 
Choose default program… 

 

2. Select the program you would like to open the file 
with and check Always use selected program to 
open this kind of file. Click OK. 
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3. Your files will now open in the new program by 
default. 

 



 

 

Index 

Coming soon… 

 



 

 

  

If you enjoyed this book, please consider making a 
donation. 
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